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The Living Image® 3.2 software controls image acquisition on the IVIS® Kinetic. The 
application also provides tools for optimizing image display and analyzing images or 
kinetic data.

1.1 What’s New In the Living Image 3.2 Software

The Living Image 3.2 software enables kinetic data acquisition on the IVIS® Kinetic and 
provides tools for visualizing and analyzing kinetic data.

1.2 About This Manual

This user manual explains how to acquire and analyze images or kinetic data on the 
IVIS® Kinetic. The manual provides detailed instructions and screenshots that depict the 
system response. 

NOTE
Sometimes the screenshots in the manual may not exactly match those displayed on 
your screen.

For more details on the IVIS Kinetic, please see the appropriate IVIS Kinetic System 
Manual.

New Feature or Updated Tool See Page

Acquire and analyze luminescent or fluorescent signals in real-time 37

14-bit or 16-bit dynamic range 39

EM gain option multiplies the signal for fast imaging applications 40

Maximum signal vs. time graph plots the maximum signal in each frame of the 
kinetic data and provides a convenient way to see signal trends

41

View the cumulative signal to track signal changes in real time 40

Kinetic ROIs are applied to each frame in a kinetic data set and are displayed during 
kinetic data playback

94

Edit kinetic data 42

Save kinetic data in DICOM format (.dcm) or save kinetic images to a movie (for 
example, .mpg4)

43
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Conventions Used In 
the Manual

Living Image Help There are several ways to obtain help on the software features:

• To view a tooltip about a button function, put the mouse cursor over the button.

• To view a brief description about an item in the user interface, click the  toolbar 
button, then click the item.

• Press F1 or select Help → User Guide on the menu bar to display the Living Image 
3.2 Software User’s Manual (.pdf).

Convention Example

Menu commands are bolded. To open image data, select File ➞Open Dataset on the 
main bar.

Toolbar button names are bolded. To open image data, click the Open Dataset button 
.

Numbered steps explain how to carry 
out a procedure.

1. To start the Living Image software, click the  
icon on the desktop.

A dash (—) precedes the description 
of the system response to a 
procedure.

— The main window appears.

Document names are italicized. Living Image Software User’s Guide

Note information NOTE
A note presents pertinent details on a topic.

or 

Note: Notes also appear in this format.

Caution information CAUTION!
CAUTION!  A caution note warns you that your 
actions may have nonreversible consequences 
or may cause loss of data.

Important information IMPORTANT!
ALERT!  Important information advises you of 
actions that are essential to the correct 
performance of the instrument or software.
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1.3  Contacting Caliper Technical Support

If you need technical support, please contact Caliper at:

Telephone: 1.877.LabChip (877.522.2447) Toll Free in the United States)

1.508.435.9761 

E-mail: tech.support@caliperls.com

Fax: 1.508.435.0950

Address: Caliper Life Sciences

68 Elm Street

Hopkinton, MA 01748

USA
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2 Getting Started

Overview of Imaging & Image Analysis .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  5
For more details on sequence setup using the imaging wizard, see page 24.  .  .  .  .  .  .  8
Initializing the IVIS® Imaging System   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 11
Checking the System Temperature   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 11

This chapter provides a brief overview of images and image analysis. It also explains 
how to start the Living Image® software and initialize the IVIS® imaging system.

2.1 Overview of Imaging & Image Analysis

For bioluminescence imaging, the imaging system acquires a photographic image and a 
bioluminescence image. The Living Image software automatically coregisters the 
images to generate an overlay image (Figure 2.1). For fluorescence imaging, the IVIS® 
imaging system acquires a photographic and fluorescence image that are used to 
generate an overlay image. 

Figure 2.3 shows an example workflow on an IVIS® Imaging System.

Table 2.1  Images used to generate an overlay image

Image Type Description

Photographic A short exposure of the subject illuminated by the lights located at the top 
of the imaging chamber (Figure 2.2). The photographic image is displayed 
as a grayscale image.

Bioluminescence A longer exposure of the subject taken in darkness to capture low level 
bioluminescence emission. The bioluminescence image is displayed in 
pseudocolor that represents intensity (Figure 2.1). For more details on 
bioluminescence image data, see Appendix D, page 211.

Fluorescence An exposure of the subject illuminated by filtered light. The target 
fluorophore emission is captured and focused on the CCD camera. 
Fluorescence image data can be displayed in units of counts or photons 
(absolute, calibrated), or in terms of efficiency (calibrated, normalized). For 
more details on fluorescence image data, see Appendix F, page 223
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Figure 2.1  Example bioluminescence overlay image 
The Living Image® software automatically coregisters the photographic and bioluminescence 
images to generate the overlay image.

Figure 2.2  IVIS® Imaging System 100 Series, interior view. 

Photographic image Bioluminescent image Overlay image

Illumination LEDs

Camera lens opening

Sample stage
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Figure 2.3  Example imaging and analysis workflow

➊ Start the Living Image® software. In the control panel 
that appears, initialize the IVIS® imaging system.

➌ Specify acquisition settings for a single image, image 
sequence, or kinetic sequence.

➍ Acquire the image(s) or kinetic sequence.

➏ View the image(s) or kinetic data. Analyze an image (Table 2.2), image sequence  (Table 2.3), or kinetic data

➋ Confirm the default user preferences or specify 
new preferences.

Tool 
palette
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NOTE
For more details on sequence setup using the imaging wizard, see page 24.

Table 2.2  Image or kinetic sequence analysis tools

Tool Palette Use The Tools to... See Page

Image Adjust • Tune the photograph brightness, gamma (similar to contrast), or opacity
• Set the image display color scale min and max
• Select a color table for image display

62

Corrections/Filtering • Subtract dark background from the image data
• Apply flat field correction to the image data
• Specify pixel binning
• Smooth the pixel signal

66

Image Information • Display x,y coordinates and intensity data at a user-selected location on the image
• Display a histogram of pixel intensities in an image
• Plot the intensity (y-axis) at each pixel (x-axis) along a user-specified line in the image
• Measure distance in an image

67

ROI • Measure counts or photons in a user-specified region of interest (ROI) and compute 
measurement statistics (for example, average, min, max, standard deviation)

• Measure efficiency in the ROI and compute measurement statistics (for fluorescent 
images only)

81

Table 2.3  Analyzing image sequences

Analysis Description  Wizard 
Available 

See Page

Planar Spectral Image 
Analysis

Determines the average depth and total photon flux of a bioluminescent 
point source in a user-specified region of interest. Analyzes a sequence of 
bioluminescent images acquired using different emission filters.

Yes 121

Image Math A method for mathematically combining two images (add, multiply, or 
subtract). Use image math to:

• Remove autofluorescence from a fluorescent image
• Display multiple bioluminescent or fluorescent images on the same 

photographic image so that you can view multiple reporters in one image

No 118

Spectral Unmixing Removes tissue autofluorescence from a fluorescence image. Analyzes a 
sequence of fluorescence images acquired using the fluorophore 
excitation filter and several different emission filters. Spectral unmixing can 
be applied to images acquired using epi-illumination (excitation light above 
the stage) or transillumination (excitation light below the stage).

Yes 121

Point Source Fitting Estimates the optical properties of tissue, the location and power of a point 
source, or the fluorescent yield of fluorophores.

Yes 143

3D Fluorescence 
Imaging Tomography 
(FLIT™)

A 3-dimensional reconstruction of the image (tomographic analysis) that 
estimates the location and intensity of a fluorescent light-emitting source. 
Analyzes a sequence of fluorescent images acquired on the IVIS Spectrum 
at different transillumination points (excitation light below the stage).

Yes 152

3D Diffuse 
Luminescence 
Tomography (DLIT™)

A 3-dimensional reconstruction of the subject (tomographic analysis) that 
estimates the depth and intensity of a bioluminescent light-emitting 
source.

Yes 156
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2.2 Starting the Living Image® Software

For information on installing the software, see the Installation Guide included on the 
Living Image CD ROM. By default, the software is installed at:

PC: C:Programs:Xenogen:Living Image 3.2

Macintosh: Applications:Xenogen:LivingImage 3.2

NOTE
All components of the IVIS® Imaging System should be left on at all times due to the 
long cooling time required to reach operating (demand) temperature. It is also 
important to leave the system on to enable automatic overnight electronic background 
measurements. Periodically rebooting the computer is permissible and does not affect 
the camera operation.

To start the software:

1. PC Users: Click the Windows Start menu button  and select All Programs → 
Living Image. Alternatively, click the Living Image® software desktop icon .

Macintosh Users: Click the Living Image software desktop icon  or run the 
software from the application folder.
- The main window appears.

2. Select a user ID from the drop-
down list or enter a new User ID 
(up to three letters), and click OK.
- The control panel appears if the 

workstation controls the IVIS 
Imaging System (see next page).
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NOTE
The Living Image® software on the PC workstation that controls the IVIS® Imaging 
System includes both the acquisition and analysis features. The Living Image software 
on other workstations includes only the analysis features. Macintosh users have 
access to only the analysis features of the Living Image software.

There are several ways to obtain help on the software features:

• To view a tooltip about a button function, put the mouse cursor over the button.

• To view a brief description about an item in the user interface, click the  toolbar 
button, then click the item.

Press F1 or select Help → User Guide on the menu bar to display the Living Image 3.2 
Software User’s Manual (.pdf).

Menu bar (for more details, see Appendix J, page 261)

Toolbar 

The acquisition control panel when the workstation controls the IVIS® Imaging 
System (for more details, see Appendix A, page 191).
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2.3  Initializing the IVIS® Imaging System

The imaging system must be initialized each time the Living Image® software is started, 
or if the power has been cycled to the imaging chamber or the camera controller (a 
component of some IVIS systems). The initialization procedure moves every motor-
driven component in the system (for example, stage and lens) to a home position, resets 
all electronics and controllers, and restores all software variables to the default settings. 
Initialization may be useful in error situations. For further details on instrument 
operation, see the hardware manual for your IVIS Imaging System.

To initialize the imaging system:

1. Start the Living Image software (double-click the  icon on the desktop).

2. In the control panel that appears, click Initialize.
- You will hear the motors move.

NOTE
The control panel is only available on the workstation that controls the imaging 
system. The items available in the IVIS® System control panel depend on the 
particular IVIS Imaging System and the imaging mode selected (luminescent or 
fluorescent, Image Setup or Sequence Setup mode).

2.4 Checking the System Temperature

The temperature box in the IVIS acquisition control panel indicates the temperature 
status of the charge coupled device (CCD) camera (Figure 2.4). After you initialize the 
system, the temperature box turns green when the temperature is locked at the demand 
temperature (-90°  C or -105°  C for IVIS Systems cooled by a Cryotiger® unit), 
indicating the instrument is ready for operation and image acquisition.

The demand temperature for the CCD camera is fixed. Electronic feedback control 
maintains the CCD camera temperature to within a few degrees of the demand 
temperature. 

The default stage temperature on the IVIS® imaging system is 37°  C, but may be set to 
a temperature from 25-40°  C.
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NOTE
The items in the IVIS System control panel depend on the particular IVIS Imaging 
System and the imaging mode selected (luminescent or fluorescent, Image Setup or 
Sequence Setup mode). For more details on the control panel, see Appendix A, 
page 191.

The IVIS® Imaging System is ready for image acquisition after the system is initialized 
and the operating (demand) temperature of the CCD camera is reached (locked). The 
Living Image® software on the PC workstation that controls the IVIS Imaging System 
includes both the acquisition and analysis features. The Living Image software on other 
workstations includes only the analysis features.

2.5 About the IVIS Acquisition Control Panel & Auto Exposure Feature

The control panel (Figure 2.5) provides the image acquisition functions. For details on 
the imaging parameters in the control panel, see Appendix A, page 191.

The auto exposure setting is useful in situations where the signal strength is unknown 
or varies widely, for example during a time course study. When you choose auto 
exposure (Figure 2.5), the system acquires an image at maximum sensitivity, then 
calculates the required settings to achieve, as closely as possible, an image with a user-
specified target max count. If the resulting image has too little signal or saturated 
pixels, the software adjusts the parameters and takes another image.

Figure 2.4  IVIS® acquisition control panel

Temperature box color indicates:

System not initialized.

System is initialized, but CCD camera 
temperature is out of range.

System is initialized and CCD camera is at or 
within acceptable range of the demand 
temperature and locked. The system is ready 
for imaging.

Click the temperature box to 
view the demand and 
measured temperatures of 
the CCD camera and stage.
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In most cases, the default auto exposure settings provide a good bioluminescence or 
fluorescence image. However, you can modify the auto exposure preferences to meet 
your needs. For more details, see page 199.

NOTE
The options available in the IVIS acquisition control panel depend on the selected 
imaging mode, the imaging system, and the filter wheel or lens option that are 
installed.

Figure 2.5  IVIS acquisition control panel, auto exposure selected

To acquire an image using auto exposure, 
click the  arrow and select Auto.

Luminescence 
imaging settings

Fluorescence 
imaging settings

Photographic 
imaging settings

Structured light 
imaging settings
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3  Acquire an Image or Image Sequence

Acquire a Bioluminescence Image .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 15
Acquire a Fluorescence Image With Epi-Illumination  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 18
Acquire a Fluorescence Image With Transillumination  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 19
Acquire an Image Sequence   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 22
Manually Setting the Focus  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 34
Manually Saving Image Data  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 34
Exporting Image Data   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 35

The IVIS® Imaging System is ready for image acquisition after the system is initialized 
and the CCD camera reaches operating (demand) temperature (locked). 

3.1 Acquire a Bioluminescence Image

3. Put a check mark next to Luminescent.

4. Confirm that Excitation Filter setting is Block and the Emission Filter setting is 
Open.

5. Select the Auto exposure time (click the  arrow). Alternately, manually set the 
exposure, binning, and F/Stop. (For more details on the control panel settings, see 
page 191.)

6. Set the field of view: Make a selection from the Field of View drop-down list. For 
more details on the field of view, see page 160.

1. Start the Living Image software (double-click the  icon on the desktop).

2. Initialize the IVIS System and confirm or wait for the CCD temperature to lock. (For 
more details, see page 11.)
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NOTE
To view the subject(s) inside the chamber before image acquisition, take a 
photographic image (uncheck the luminescent or fluorescent option, choose the 
Photographic and Auto options, and click Acquire).

7. Set the focus: 

• Select use subject height from the Focus drop-down list and use the  arrows 
or the keyboard arrows to specify a subject height (cm). 
or

• Select Manual focus from the Focus drop-down list. (For more details on manual 
focusing see page 34.)

8. Set the photographic image settings:

a. Choose the Photographic option.

b. Enter an exposure time or choose the Auto option.

c. Confirm the binning and f/stop defaults or specify new settings for the photographic 
image.

9. If necessary, click  in the control panel to operate in single image mode.

NOTE
In single image mode, the  button appears in the control panel. Click this 
button to set up sequence acquisition. (For more details on setting up a sequence, 
see page 22.)

10. When you are ready to acquire the image, click Acquire. During image acquisition, 
the Acquire button becomes a Stop button. To cancel the acquisition, click Stop. 
- The image window appears (Figure 3.1). If this is the first image of the session, 

you are prompted to choose an autosave location.

11. To specify a folder for autosaved data, click Yes in the prompt and choose a folder 
in the dialog box that appears.
- All images acquired during the session are automatically saved to this folder. You 

can choose a different folder at any time (select Acquisition → Auto-Save on the 
menu bar).

12. In the Edit Image Labels box that appears, enter information for the image label and 
click OK (Figure 3.1). If you do not want to enter label information, click Cancel.
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Figure 3.1  Image window & Edit Image Labels box

Tool 
palette

Color bar

Image 
label

Edit Image Labels box

In the color bar, check the image min and max to determine whether the signal of 
interest is above the noise level and below CCD saturation. For 16 bit imaging, a 
signal ranging from ~600 - 60,000 counts is recommended; for 14-bit imaging, 
~600-16,000 counts are recommended. If the signal level is unacceptable, adjust 
the exposure time or binning level. For more details on the image window, see 
Table 3.1, page 18.

Edit the label information here.
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3.2 Acquire a Fluorescence Image With Epi-Illumination

Epi-illumination uses an excitation light source located above the stage. For more 
details on fluorescence imaging, see page 169.

1. Start the Living Image software (double-click the  icon on the desktop).

2. Initialize the IVIS System and confirm or wait for the CCD temperature to lock. (For 
more details, see page 11.)

3. Put a check mark next to Fluorescent.

4. Confirm that the Fluorescent Lamp Level is set to the appropriate level (High or 
Low).

5. Select the Auto exposure time (click the  arrow). Alternately, manually set the 
exposure, binning, and F/Stop. (For more details on the control panel settings, see 
page 191.)

6. Set the FOV: To adjust the field of view (FOV), make a selection from the Field of 
View drop-down list. For more details on FOV, see page 160.

Table 3.1  Image window

Item Description

Units Select the measurement units for the image display (counts, photons, or 
efficiency) from this drop-down list

Display Select the image type (for example, overlay) that you want to display from this 
drop-down list. For more details on the different types of image displays, see 
Figure 5.6, page 57.

Info Click to display or hide the image label information.

Opens a dialog box that enables you to export the active view as a graphic file.

Color bar Shows the minimum and maximum pixel intensities in the image as well as the 
color bar. Pixels less than the color bar minimum or greater than the color bar 
maximum are not displayed in the image.

Image label Information about the image that the software automatically records and user-
specified information entered in the Edit Image Label dialog box.
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NOTE
To view the subject(s) inside the chamber before image acquisition, take a 
photographic image (clear the luminescent or fluorescent option, choose the 
Photographic and Auto options, and click Acquire).

7. Set the focus: 

• Select use subject height from the Focus drop-down list and use the  arrows or 
the keyboard arrows to specify a subject height (cm). 
or

• Select Manual focus from the Focus drop-down list. (For more details on manual 
focusing see page 34.)

8. If necessary, click  in the control panel to operate in single image mode.

NOTE
In single image mode, the  button appears in the control panel. Click this 
button to set up sequence acquisition. (For more details on setting up a sequence, see 
page 22.)

9. When you are ready to acquire the image, click Acquire. During image acquisition, 
the Acquire button becomes a Stop button. To cancel the acquisition, click Stop. 
- The image window appears (Figure 3.1). If this is the first image of the session, you 

are prompted to choose an autosave location.

10. To specify a folder for autosaved data, click Yes in the prompt and choose a folder 
in the dialog box that appears.

- All images acquired during the session are automatically saved to this folder. You 
can choose a different folder at any time (select Acquisition → Auto-Save on the 
menu bar).

11. In the Edit Image Labels box that appears, enter information for the image label and 
click OK (Figure 3.1). If you do not want to enter label information, click Cancel.

3.3 Acquire a Fluorescence Image With Transillumination

Transillumination uses an excitation light source located below the stage. For more 
details on fluorescence imaging, see page 169.

NOTE
Transillumination is only available on the IVIS® Spectrum imaging system.
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1. Start the Living Image software (double-click the  icon on the desktop).

2. Initialize the IVIS System and confirm or wait for the CCD temperature to lock. (For 
more details, see page 11.)

3. Put a check mark next to Fluorescent and Transillumination.

4. In the control panel, select an appropriate excitation filter and emission filter from 
the drop-down lists.

5. Click Setup.

6. In the Transillumination Setup box 
that appears, choose the locations for 
transillumination and image 
acquisition and click OK.

For more details on the 
Transillumination Setup box, see 
Table 3.2.
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7. Set the FOV: To adjust the field of view (FOV), make a selection from the Field of 
View drop-down list. For more details on FOV, see page 160.

NOTE
To view the subject(s) inside the chamber before image acquisition, take a 
photographic image (clear the luminescent or fluorescent option, choose the 
Photographic and Auto options, and click Acquire).

8. Set the focus: 

• Select use subject height from the Focus drop-down list and use the  arrows or 
the keyboard arrows to specify a subject height (cm). 
or

• Select Manual focus from the Focus drop-down list. (For more details on manual 
focusing see page 34.)

9. If necessary, click  in the control panel to operate in single image mode.

NOTE
In single image mode, the  button appears in the control panel. Click this 
button to set up sequence acquisition. (For more details on setting up a sequence, see 
page 22.)

10. When you are ready to acquire the image, click Acquire. During image acquisition, 
the Acquire button becomes a Stop button. To cancel the acquisition, click Stop. 
- The image window appears (Figure 3.1). If this is the first image of the session, you 

are prompted to choose an autosave location.

Table 3.2  Transillumination Setup box

Item Description

Move Motors To 
Selected Spot

Transillumination motors will move to the grid location selected in the 
Transillumination Setup dialog box.

Transillumination 
Lamp Source

Choose this option to turn on the bottom illumination lamp.

Mask Grid points 
To Subject

Choose this option to select only the grid locations within the subject. 
Grid locations outside the subject are masked.

Grid Type Select a grid type from the drop-down list: 15x23, 11x23, 5x10, or 8x12 
well plate, Xenogen Sparse Mask, 6x8x1cm.

Grid Display Select "Points" or "Cross Hair" to display the grid.

Update Photograph Click to acquire a new photographic image. If the chamber door is opened 
during transillumination setup, you are prompted to acquire a new 
photograph.

Clear Selections Clears selected/ highlighted transillumination locations on the grid.
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11. To specify a folder for autosaved data, click Yes in the prompt and choose a folder 
in the dialog box that appears.
- All images acquired during the session are automatically saved to this folder. You 

can choose a different folder at any time (select Acquisition → Auto-Save on the 
menu bar).

12. In the Edit Image Labels box that appears, enter information for the image label and 
click OK (Figure 3.1). If you do not want to enter label information, click Cancel.

3.4 Acquire an Image Sequence

A sequence is a collection of images that are grouped together in a single folder. A 
sequence may include images that were acquired during the same session and were 
intended to be grouped together (for example, images taken at different exposure times 
or an image sequence for DLIT™ or FLIT™ 3-D tomographic analysis).

Images that were acquired during different sessions can also be grouped together to 
form a sequence. For example, a time series could be constructed from images acquired 
on different days following an experimental treatment. (For more details, see page 26.)

Some analyses are performed on an image sequence (see Table 3.3). The sequence 
requirements (number and type of images) depend on the analysis. The imaging wizard 
provides a convenient way to set up several types of image sequences (see page 24). 
You can also set up the sequence manually (see page 26). 
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*Optional: with premium filters

Table 3.3  Application-specific image sequences

Analysis IVIS Imaging System

Lumina 100 Series 200 Series Spectrum Kinetic

Planar spectral image analysis

Computes the total flux and average depth of a 
bioluminescent source below the surface.

Optional* Optional* T T Optional*

Display multiple fluorescent or bioluminescent 
reporters.

Uses the Image Overlay function to display multiple 
luminescent or fluorescent images on one photographic 
image.

T T T T T

Subtract tissue autofluorescence using blue-shifted 
background filters.

Uses the image math feature to subtract a background 
image from the primary image.

T T T T T

Point Source Fitting

Estimates the optical properties of tissue, the location and 
power of a point source, or the fluorescent yield of 
fluorophores.

T T T T T

Spectral unmixing 

Removes tissue autofluorescence from a fluorescence 
image.

Optional* Optional* T T Optional*

DLIT™ Analysis

Reconstructs the surface topography of the subject and the 
brightness and 3D location of bioluminescent sources.

T T T

FLIT™ Analysis 

Reconstructs the surface topography of the subject and 
brightness and 3D location of fluorescent sources.

T T
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Setting Up a Sequence 
Using the Imaging 
Wizard

The imaging wizard can automatically setup an image sequence for some applications 
that analyze an image sequence (Table 3.3). The wizard guides you through a series of 
steps, prompting you for the information that the software requires to set up the image 
sequence.

Table 3.4  Imaging wizard sequence options

Bioluminescence Acquires... Description  See 
Page

Image Sequence

Open Filter T Acquires an image at maximum sensitivity.

Planar Spectral T Analyze the sequence to compute the average depth and total 
photon flux of a bioluminescent point source in a region of interest 
(ROI).

121

Spectral 
Unmixing

T Analyze the sequence to determine spectral signature of different 
reporters in the same image and calculate the contribution of each 
reporter on each pixel in the image.

127

DLIT T Apply the DLIT™ algorithm to the sequence to reconstruct the 3D 
surface topography of the subject and the position, geometry, and 
strength of the luminescent sources.

151

Fluorescence Description See 
Page

2D T T Use the data to make fluorescence measurements. 

Filter Scan T Helps you determine the optimum excitation and emission filter for 
a probe.

Spectral 
Unmixing

T Analyze the sequence to extract the signal of one or more 
fluorophores from the tissue autofluorescence.

127

FLIT T Apply the FLIT™ algorithm to the sequence to reconstruct the 3D 
surface topography of the subject and the position, geometry, and 
strength of the fluorescent sources.

156
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To set up a sequence using the imaging wizard:

1. Click Sequence Setup in the IVIS acquisition control panel.
- The Sequence Editor appears.

4. If necessary, click  and select All to clear the Sequence Editor.

5. Click Imaging Wizard.

Sequence Editor

To begin setting up a bioluminescence 
image sequence, click here.

To begin setting up a fluorescence 
image sequence, click here.

6. Click Next.

Sequence Editor
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NOTE
The imaging options available in the imaging wizard depend on the IVIS imaging 
system and the installed filter set.

Manually Setting Up a 
Sequence

You can manually set up an image sequence in the control panel and save the 
information to a Xenogen Sequence Setup file (.xsq).

NOTE
To create an image sequence, it may be convenient to edit a sequence setup 
generated by the imaging wizard or an existing sequence setup (.xsq). Save the 
revised sequence setup to a new name.

1. Click Sequence Setup in the control panel.

7. Double-click the type of bioluminescence or fluorescence sequence that you want 
to acquire and step through the rest of the imaging wizard.
- The sequence setup appears in the Sequence Editor.

Imaging wizard - Bioluminescence Imaging wizard - Fluorescence
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2. If it is necessary to clear the sequence editor that appears, click  and select 
All.

3. In the control panel, specify the settings for the first bioluminescence or 
fluorescence image in the sequence and the photographic image. (For details on the 
imaging parameters in the control panel, see page 191.)

NOTE
If you choose the photograph Reuse option in the control panel, the IVIS® System 
acquires only one photographic image for the entire sequence. If this option is not 
chosen, the system acquires a photographic image for each image in the sequence.

4. Click .
- The acquisition parameters are added to the table. 

Sequence Editor

Reuse option
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5. Repeat step 3 to step 4 for each image in the sequence.

6. To specify a time delay between each acquisition, enter a time in the Delay (min) 
box in the Sequence Editor.

7. If you want to save the sequence setup information (.xsq):
a. In the sequence editor, click the Save button .

b. In the dialog box that appears, select a directory for the file, enter a file name, and click 
Save.

Click to include the parameter settings 
for the photographic image in the editor.

Each row in the editor specifies the acquisition 
parameters for one image in the sequence

The image(s) in the sequence editor comprise one segment. You can acquire multiple 
segments with a user-specified time delay between acquisitions. This is useful for 
acquiring data for kinetic analysis.



29

Living Image® Software User’s Manual

Editing an Image 
Sequence

You can edit a parameter value, as well as add or remove images from the sequence. A 
shortcut menu of edit commands is available when you right-click the Sequence Editor.

Table 3.5  Sequence Editor

Item Description

Starts the imaging wizard.

Displays a dialog box that enables you to select and open a sequence 
setup (.xsq), sequenceinfo.txt, or clickinfo.txt file.

Displays a dialog box that enables you to save a sequence setup (.xsq).

Display Photographic 
Settings

Choose this option to include the photograph exposure time, binning, 
and F/Stop in the sequence editor.

Number of Segments Choose this option to set the number of segments to acquire and the 
time delay between segments. One segment = the sequence 
specified in the sequence editor.

Delay Specifies a time delay between each segment acquisition.

Applies the selected cell value to all cells in the same column.

Deletes the selected row from the sequence editor.

Updates the selected row in the sequence editor with the acquisition 
parameters in the control panel.

Changing an Imaging Parameter

1. In the sequence editor, double-click the cell that you want to edit.

2. Enter a new value in the cell or make a selection from the drop-down list.

3. To apply the new value to all of the cells in the same column, click .

4. Click outside the cell to lose focus.

Editing a parameter using the control panel
1. In the sequence editor, select the row that you want to modify.

2. In the control panel, choose new parameter values and/or imaging mode.

3. Click .

Control panel Sequence editor

For details on these functions, see Table 3.5.
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Adding or Deleting Images From a Sequence

Alternate method to add a row:

1. In the sequence editor, select the row next to where you want to insert the image.

2. Set the imaging mode and parameters in the control panel.

3. To insert the new image above the selected row, click . To insert the 
new image below the selected row, click .

Inserts a row above the currently selected row using the information 
from the control panel.

Adds a new row below the currently selected row using information 
from the control panel.

Table 3.6  Sequence editor, shortcut menu edit commands

Command Description

Copy row(s) Copies the selected row(s) to the system clipboard.

Select All Selects all rows in the sequence editor.

Delete row(s) Deletes the selected row(s) from the sequence editor.

Replace Row(s) Replaces the row(s) selected in the sequence editor with the rows in the 
system clipboard. 

Note: The Replace function is only available when the number of rows in 
the system clipboard is the same as the number of rows selected in the 
sequence editor.

Paste Row(s) Adds copied rows to end of the sequence.

Table 3.5  Sequence Editor

Item Description

1. Select the row(s) of interest and right-click the sequence editor to view a shortcut 
menu of edit commands (see Table 3.6).
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Alternate method to delete one or more rows:

1. Select the row(s) that you want to delete.

2. Click  and choose Selected from the drop-down list.

To clear the sequence editor:

1. Click .

2. Choose All from the drop-down list.

Acquire the Image 
Sequence

The system is ready to acquire the image sequence after you set up the image sequence 
in the sequence editor. 

1. Initialize the IVIS® System and confirm or wait for the CCD temperature to lock. (For 
more details, see page 11.)

2. When you are ready to acquire the images, click Acquire Sequence in the control 
panel.
- Thumbnail images appear as the images are acquired. During acquisition, the 

Acquire Sequence button becomes a Stop button. To cancel the acquisition, click 
Stop.

Thumbnail images

Tool palette
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3.If this is the first acquisition of 
the session, you are prompted to 
choose an autosave location. 

4. To specify a folder for autosaved data, click Yes in the prompt and choose a folder 
in the dialog box that appears.
- All sequences acquired during the session are automatically saved to this folder. 

You can choose a different folder at any time (select Acquisition → Auto-Save 
on the menu bar).

5. In the Edit Image Labels box that appears, enter information for the image label and 
click OK (Figure 3.1). If you do not want to enter label information, click Cancel.

Figure 3.2  Image window & Edit Image Label box

Open an image (double-click the thumbnail) to 
determine whether the signal of interest is 
above the noise level and below CCD 
saturation. 

Check the image min and max in the color bar. 
A signal greater than 600 counts and less than 
~60,000 counts is recommended. If the signal 
level is unacceptable, adjust the exposure 
time or binning level.

For more details on the image window, see 
Table 3.7

Image label

Edit the label information here.
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Table 3.7  Image window

Item Description

Units Select the measurement units for the image display (counts, photons, or 
efficiency) from this drop-down list

Display Select the image type (for example, overlay) that you want to display from this 
drop-down list. For more details on the different types of image displays, see 
Figure 5.6, page 57.

Info Click to display or hide the image label information.

Opens a dialog box that enables you to export the image or thumbnails to a 
graphic file (for example, .bmp or DICOM format)

Creates a preview picture of the image or thumbnails that the Living Image 
browser displays when the data is selected.

Color bar Shows the minimum and maximum pixel intensities in the image as well as the 
color bar. Pixels less than the color bar minimum are not displayed in the 
image.Pixels greater than the color bar maximum are displayed in the maximum 
color.

Image label Information about the image that the software automatically records and user-
specified information entered in the Edit Image Label dialog box.

Preview picture of the selected data
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3.5  Manually Setting the Focus

The IVIS Imaging System automatically focuses the image based on subject height (see 
page 193). If you do not want to use the automatic focus feature, you can manually set 
the focus.

1. In the control panel, choose Manual Focus in the Focus drop-down list.
- The Manual Focus window appears.

2. To mark the center of the camera in the window, put a check mark next to Display 
CCD Center.

3. Select the size of the step increment that the stage moves: Coarse, Normal, or 
Fine. 

4. Click Up or Down to move the stage and change the focus.

5. If necessary, select another F/stop setting from the drop-down list and adjust the 
light level using the  arrows.

6. Click Update to apply the settings.
- The resulting focal plane (cm above the stage) is automatically entered in the 

Subject height box.

7. Click OK when the image is focused.

3.6 Manually Saving Image Data

When you acquire the first image(s) of a session, the autosave feature prompts you to 
choose the folder where you want to save image data. During the session, all images 
will be saved to this folder. You can change the autosave folder at any time (select 
Acquisition → Auto-Save To on the menu bar). If you do not want to use the autosave 
feature, you can manually save data.

1. Turn off the autosave feature: select Acquisition on the menu bar and remove the 
check mark next to Auto Save.

2. After you acquire an image or image sequence, click the Save button . 
Alternatively, select File → Save on the menu bar. 
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3. In the dialog box that appears, select a directory of interest and click OK.

NOTE
The software automatically includes the user ID, and a date and time stamp with the 
data.

3.7 Exporting Image Data

You can export the image data in different file formats (for example, .bmp, .dcm).

1. Click the Export Graphics button .

2. In the dialog box that appears, select a directory, choose a file type, and enter a file 
name.

3. Click Save.

NOTE
When you export to DICOM (.dcm) format, a directory that contains the .dcm files and 
a SequenceInfo.txt is created at the specified location.
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4 Acquire Kinetic Data
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The IVIS® Kinetic is ready to acquire kinetic data after the system is initialized and the 
CCD camera reaches operating (demand) temperature (locked).

4.1 Kinetic Acquisition
1. Start the Living Image software (double-click the  icon on the desktop).

2. Initialize the IVIS System and confirm or wait for the CCD temperature to lock. For 
more details, see page 11.)

3. When you are ready to begin imaging, click Kinetics in the control panel.
- The Kinetic Acquisition window appears.

4. Select the type of data to acquire and set the acquisition parameters. (For more 
details on the acquisition parameters, see Table 4.1, page 39.)

Figure 4.1  Control panel (top) and Kinetic Acquisition window (bottom)
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5. Click the  button to start acquisition. (After acquisition begins, the button 
changes to a .)
- The Maximum vs. Time graph plots the maximum signal in each data frame. For 

more details on the graph, see page 41.

6. To stop acquisition, click the  button. 

Accumulated Signal The Accumulate option enables you to view increasing signals in real time. If you plan 
to accumulate signals, it is recommended that you perform a test acquisition to optimize 
settings so that the photographic image, luminescent, or fluorescent signal is not 
saturated. 

To perform a test acquisition:
1. Confirm that the Accumulate option is selected. Do not select the Auto color scale 

option.

2. Start the acquisition (click the  button). 

3. If the photographic image is saturated, stop the acquisition (click the  button) 
and reduce the photograph light level.

Figure 4.2  Kinetic Acquisition window 

After acquisition, choose 
the type of data to display

Select the type data to acquire 
(luminescent or fluorescent) 

To adjust a setting using thumb 
wheel, put the mouse arrow on 
the wheel, then click and hold the 
mouse button while you move 
the mouse arrow left or right.
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CAUTION!
CAUTION!  Extended acquisition of saturated images can shorten the life of 
the CCD and should be avoided.

4. Restart the acquisition. If necessary, repeat step 3 and step 4.

Table 4.1  Kinetic acquisition settings

Item Description

Select the type of data to acquire (luminescent or fluorescent) from 
this drop-down list. Choose the Overlay option to acquire 
photographic images.

Dynamic Range 14 bit - If this option is chosen, the signal intensities range from 0 to 
16384 counts per pixel.
16 bit - If this option is chosen, the signal intensities range from 0 to 
65536 counts per pixel. 
Note: The14 bit dynamic range enables faster imaging.

Exposure Time (msecs) The exposure time for the luminescent image. Shorter exposure 
times enable faster frame rates; longer exposure times provide 
greater sensitivity. The14 bit dynamic range enables faster imaging 
by attaining a higher frame rate at the cost of a smaller dynamic 
range.
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Binning Controls the pixel size on the CCD camera. Increasing the binning 
increases the pixel size and the sensitivity, but reduces spatial 
resolution. Binning a luminescent or fluorescent image can 
significantly improve the signal-to-noise ratio. The loss of spatial 
resolution at high binning is often acceptable for in vivo images 
where light emission is diffuse. For more details on binning, see 
Appendix C, page 206.

Recommended binning: 1-4 for imaging of cells or tissue sections, 4-
8 for in vivo imaging of subjects, and 8-16 for in vivo imaging of 
subjects with very dim sources.

F/Stop Sets the size of the camera lens aperture.The aperture size controls 
the amount of light detected and the depth of field. A larger f/stop 
number corresponds to a smaller aperture size and results in lower 
sensitivity because less light is collected for the image. However, a 
smaller aperture usually results in better image sharpness and depth 
of field.

In kinetic mode, the photographic and luminescent (or fluorescent) 
image are acquired at the same F/Stop. For more details on f/stop, 
see Appendix C, page 205.

EM Gain Multiplies the signal in real time. This option is useful for boosting 
low signals above the background noise. For kinetic imaging, the EM 
gain may be set to 50, 100, or 250. For conventional 16-bit still image 
acquisition, EM gain may be set to Off, 50, 100, or 250.

Excitation Filter A drop-down list of fluorescence excitation filters. For fluorescent 
imaging, choose the appropriate filter for your application (GFP, 
DsRed, Cy5.5, or ICG). For bioluminescent imaging, Block is 
selected by default. If you select Open, no filter is present. 

Lamp Level Sets the illumination intensity level of the excitation lamp used in 
fluorescent imaging (Off, Low, High, and Inspect). 

Low - This setting is approximately 18% of the High setting. 

Inspect -Turns on the illumination lamp so that you can manually 
inspect the excitation lamp. 

Note: Make sure that the filters of interest are selected in the filter 
drop-down lists before you select Inspect. The Inspect operation 
automatically positions the selected filters in the system before 
turning on the lamp. Subsequent changes to the filter popup menus 
will have no effect until another Inspect operation is performed.

Photograph Light Level Controls the brightness of the lights at the top of the imaging 
chamber that are used to acquire photographic images.

Accumulate Select this option to view the cumulative intensity signal in real time. 
When this option is chosen, the software computes and visualizes 
the cumulative signal in each frame. 

Color Scale Auto - If this option is chosen, the software chooses the color scale 
minimum and maximum. Note: Do not choose this option if the 
Accumulate option is selected.
Minimum - A user-specified threshold for the color scale minimum 
that is applied to the data if the Auto option is not selected. Intensity 
signals less than the minimum are not displayed. 
Maximum - A user-specified threshold for the color scale maximum 
that is applied to the data if the Auto option is not selected.

File Size Displays the file size of the kinetic stream (.dcm) being acquired. The 
file size display is only available in the Kinetic Acquisition panel.

Table 4.1  Kinetic acquisition settings (continued)  

Item Description
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Maximum vs. Time 
Graph

The maximum vs. time graph appears when kinetic acquisition begins and plots the 
maximum intensity signal in each frame. The graph provides a convenient way to look 
for signal trends or select particular frames for viewing.

Save Click to select an option for saving the data:
Save Current Image - Saves the currently selected frame (single 
image, photograph, and read bias).
Save Accumulated Image - Saves the accumulated signal for the 
selected frames (.tiff).
Save Kinetic Data - Saves all selected photographic, luminescent 
or fluorescent images (frames) and the read bias image (.dcm). 
The signal is not accumulated.

Done Closes the Kinetic Acquisition window

Table 4.1  Kinetic acquisition settings (continued)  

Item Description

Figure 4.3  Maximum vs. time graph

• Click a point in the graph to view the corresponding image (frame)

• Put the mouse pointer over the graph to view a tooltip that shows the frame 
number and time

• Right-click the graph to view the available shortcut menu of graph display options
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4.2 Viewing & Editing Data (Kinetic Acquisition window)

After stopping acquisition, you can view the data in the Kinetic Acquisition window. 

1. To start the playback, click the  button. (After playback starts, the button 
changes to .)

2. To stop the playback, click the  button.

3. To view a particular frame, do one of the following:

• Move the top frame slider or enter a frame number in the box next to the frame 
slider

• Click a location in the Maximum vs. Time graph

4. To select a particular range of kinetic data, move the start and end frames selection 
handles. Alternately, enter a frame number in the box next to each slider. Only the 
selected frames will be played back or saved.

NOTE
Kinetic data (.dcm) can also be edited in the Image window. For more details, see 
page 77.

Figure 4.4  Acquisition window

Current frame number. Enter a new number 
or use the top slider to view another frame.

Start frame in a user-specified data range 

= Position of the displayed (current) frame

= Position of the start frame

= Position of the end frame

Frame number 121
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Viewing Options After acquisition has been stopped, right-click the image to access a shortcut menu of 
viewing options.

4.3 Saving Data

The IVIS® Kinetic instrument enables you to acquire a real-time data stream which can 
generate very large files.  The file size limit for DICOM data is 2GB. Kinetic data 
acquisition automatically stops when this file size limit is reached.  Table 4.3 shows how 
binning conditions affect the total number of frames that can be collected in overlay or 
luminescent/fluorescent only mode.

Table 4.2  Kinetic view options

Item Description

Zoom Area To magnify a particular area, draw a box around the area that you 
want to zoom in on, right-click the area and select Zoom Area on the 
shortcut menu.

Zoom In Incrementally magnifies the view.

Zoom Out Incrementally reduces the magnification.

Reset Zoom Returns the image to the default display magnification.

Pan View Enables you to view a different area of a magnified image. To view 
another area of the image, choose this option, then click and hold the 
pointer while you move the mouse over the image. 

Crop Area To crop the image, draw a rectangle over the area of interest in the 
image, then right-click the area in the box and select Crop Area on the 
shortcut menu.

Draw Grid Displays a grid over the frame.

Draw Scale Displays a scale along the x- and y-axis of the frame.

Insert Tag Displays a tag with x,y pixel information at a user-selected location of 
the image. To insert a tag, right-click a location in the image and 
choose Insert Tag on the shortcut menu.

Remove Tag Removes a user-selected tag from the image.

Remove All Tags Removes all tags from the frame.

Display Color Bar Choose this option to display the color bar.

Display Color Min/Max Choose this option to display the color bar minimum and maximum.

Display Image Min/Max Choose this option to display the minimum and maximum signal.

Table 4.3  Frames collected per 1 GB DICOM file

Binning Level Frame Size Overlay 
Mode

Luminescent or 
Fluorescent Only

DICOM File Size

Total Frames Collected

Bin1 2 MB 250 500

Bin2 512 KB 975 1950 1 GB

Bin 4 128 KB 3900 7800

Bin 8 32 KB 15600 31250

Bin 16 8 KB 62500 125000
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To save data:
1. In the Kinetic Acquisition window, click the Save button and select a save option.

2. In the Edit Image Labels box that appears, enter information for the image label and 
click OK. If you do not want to enter label information, click Cancel.

NOTE
You can edit and analyze kinetic data in the Image window.

Save Option Description

Save → Current Image Saves the currently displayed frame.

Save → Accumulated Image Saves the accumulated signal for the selected frames (.tiff). 
Note: It is not necessary to select the Accumulate option to 
save an accumulated image.

Save → Kinetic Data Saves the data (photographic frames, all luminescent or 
fluorescent frames, and read bias) in DICOM format (.dcm).

Figure 4.5  The Edit Image Labels box, Image window, and tool palette appear when you save 
an image or kinetic stream

Tool palette

Edit Image Labels box

Image window

Kinetic Acquisition window
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5.1 Browsing & Opening Data

The Living Image® Browser provides a convenient way to browse and preview data, 
view information about the data, and open a single image, image sequence or kinetic 
data. You can also navigate to data and open it without the browser (see page 49).

Browsing Data

NOTE
The next time you start the Living Image software and open the Browse For Folder 
box, the software automatically returns to the last folder visited.

1. Click the Browse button . Alternatively, select File → Browse from the menu bar.

2. In the Browse for Folder box that appears, select the data of interest and click OK.
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Table 5.1  Living Image® browser

Item Description

Hide Browse View Closes the browser table.

Close Preview Closes the image preview box.

Label Set A drop-down list of the available label sets which specify image 
information (column headers) that is displayed in the Living Image 
browser.

Add to List If you choose this option, the data that you select in the Browse for 
Folder box is added to the Living Image browser. If this option is not 
chosen, the data that you select in the Browse for Folder box replaces 
the contents of the Living Image browser.

Browse Opens the Browse For Folder box.

Load as Group Enables you to select particular images that you want to view as a 
sequence. The images may be acquired during different sessions.

To select adjacent images in the browser, press and hold the Shift 
key while you click the first and last file in the selection. 

To select non-adjacent images in the browser: 

PC users: Press and hold the Ctrl key while you click the images 
in the browser
Macintosh users: Press and hold the Cmd key (apple key) while 
you click the images in the browser. 

Note: The Load as Group option is only available when two or more 
images are selected in the browser.

Load Opens the selected image or image sequence.

Remove Removes a user-selected image sequence(s) from the browser.

Close Closes the Living Image browser.

3. The selected data are displayed in the Living Image browser along with the user ID, 
label information, and camera configuration information. 

 - an image 
 - an image sequence
 - a kinetic data

4. Click the + sign to show the images of a sequence. To view data properties, right-
click the item and select Properties on the shortcut menu.
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Opening Data You can open data from the Living Image browser, the toolbar, or the menu bar. 
Multiple data sets can be open at the same time.

NOTE
To open recently viewed files, select File → Recent Files on the menu bar.

Opening Data from the 
Living Image Browser

2. To show the images in a sequence, click the + sign next to a sequence ( ).

1. To open data, do one of the following:

• Double-click the data row:
 image 
 sequence 
 kinetic data

• Right-click the data name and select Load on the shortcut menu

• Select the data row and click Load.

• Double-click the thumbnail
- The image(s) and tool palette are displayed. Open data is highlighted in green in the 

browser.
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3. To open all images in a sequence, click the Display All button  in the image 
window. To close all images, click the Hide button .

For more details on working with a 
sequence in the image window, 
see page 51.

The image window displays thumbnails of 
sequence images using a single color table. 

Double-click a thumbnail to open the image
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Opening Data from the 
Menu or Toolbar

NOTE
To open a recently viewed files, select File → Recent Files on the menu bar.

1. Click the Open button  on the toolbar. Alternately, select File → Open on the 
menu bar.

2. In the Open box that appears, 
double-click the file of interest. 
Alternately, select the data and 
click Open.

File types:
Click*.txt - an image (Living 
Image file format)
Sequence*.txt - an image 
sequence (Living Image file 
format)
*.dcm - kinetic data
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5.2  The Tool Palette & Image Window

The tool palette contains information about the data and organizes the image analysis 
tools. The tools available in the tool palette depend on the type of data that is active

An image, image sequence, or kinetic data set is displayed in an image window. 
Multiple image windows can be open at the same time. The options available in the 
image window and tool palette depend on the type of image data.

Figure 5.1  Tool palette

Figure 5.2  Image window, kinetic data

Click to expand a tool.
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5.3 Working With an Image Sequence

When you open an image sequence, the image window displays thumbnails of the 
images in the collection. A single color table is applied to the images. (For details on 
how to open an image sequence using the Living Image browser, see page 47.)

If DLIT™ or FLIT™ analysis results are loaded, click the 3D View tab to display the 3D 
reconstruction of the luminescent sources (IVIS® Imaging System 200 or Spectrum 
only). For more details on 3D reconstruction, see page 151.

Figure 5.3  Image window, sequence view 

Figure 5.4  Image window, 3D view

For details on these items, see Table 5.2

Choose Individual to 
apply a separate color 
scale to each 
thumbnail in a 
sequence.
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Editing an Image Sequence

You can add individual images to a sequence or remove user-specified images from a 
sequence.

Table 5.2  Image window, sequence view tab

Item Description

Units Choose counts, photons, or efficiency for the image data from the drop-
down list. For more details on counts, photons, or efficiency see 
Appendix D, page 213.

Use Saved Colors Choose this option to display an image using the color table that was last 
applied to the image data.

Info Click to show or hide the sequence information.

Click this button to open all images in a sequence.

Click this button to close all open images in the active sequence.

Click this button to open the Edit Sequence window that enables you to 
add or remove images from the active sequence. For more details on 
editing a sequence, see page 52.

Click this button to acquire a preview of the sequence for display in the 
Living Image browser.

1. Open the image sequence that you want to edit. (For details on how to open image 
data, see page 47).

2. If you plan to add images to the sequence, browse for the images that you want to 
add in the Living Image® browser. (For more details on browsing, see page 45.)
Note: Only individual images, not an image sequence, can be added to a sequence.

3. In the image window, click the Edit button .
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7. To restore a retired image to the sequence, select the retired image and click 
Reactivate.

8. When you are finished editing the sequence, click Close.
- The updated image sequence is displayed.

Creating an Image 
Sequence from 
Individual Images

You can create a sequence from images acquired during different sessions.

1. In the Living Image® Browser, browse for the images of interest. (For more details 
on browsing, see page 45.)

NOTE
Browse for individual images (which may or may not be part of a sequence), not image 
sequences.

Single images in the 
Living Image Browser 

Images that have 
been removed from 
the active sequence

Images in the 
active sequence

4. In the Edit Sequence box that appears, choose the image(s) that you want to add or 
remove from the sequence. 

5. To add an image to the 
sequence, select an 
image and click Copy.

6. To remove an image from the sequence, select an image and click Retire.
- The image is removed (retired) from the sequence.
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2. In the browser, select the images that you want to group together.

•To select adjacent images in the browser, press and hold the Shift key while you 
click the first and last file in the selection. 

•To select non-adjacent images in the browser: 
PC users - Press and hold the Ctrl key while you click the images of interest in the 
browser. 

Macintosh users - Press and hold the Cmd key (apple key) while you click the 
images of interest in the browser.

3. Click Load as Group.
- The image thumbnails are displayed together in an image window.
For details on how to save or export the image data, see Chapter 3, page 34.

Individual images (highlighted blue in this example) that may or may not be part of a 
sequence can be selected for grouping into a new sequence.

Images loaded in the browser as part of a sequence (highlighted pink in this 
example). These images cannot be selected for grouping into another sequence.
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5.4 Working With a Single Image

Table 5.3 explains the items in the image window. For details on how to browse data and 
open images, see page 45.

Figure 5.5  Image window, overlay display mode

To display or hide the image 
information, click Info.

Select a display mode from the drop-down list.Choose the image display units.
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Table 5.3  Image window

Item Description

Units Choose counts, photons, or efficiency from the drop-down list for the 
image data. For more details on counts, photons, or efficiency see 
Appendix D, page 213.

Display To choose an image display mode in the image window, make a 
selection from the Display drop-down list. See Figure 5.6 for examples 
of the display modes. 

Overlay A pseudocolor image of luminescent or fluorescent image data displayed 
over a grayscale photographic image.

Photograph A grayscale image that is captured when the IVIS® Imaging System 
illumination lights are activated.

Luminescent A pseudocolor image of the luminescent data captured during an 
exposure when the IVIS Imaging System illumination lights are off.

Fluorescent A pseudocolor image of the fluorescent data captured during an 
exposure when the IVIS Imaging System illumination lights are off.

Background The CCD camera background acquired with the camera shutter closed. 
(See Appendix E, page 217.)

Bias An electronic offset that exists on every pixel. This means that the zero 
photon level in the readout is not actually zero, but is typically a few 
hundred counts per pixel. The read bias offset is reproducible within 
errors defined by the read noise, another quantity that must be 
determined for quantitative image analysis.

Saturation Map Displays image regions that saturated the CCD digitizer in red. ROI 
measurements should not be made on saturated regions. ROI 
measurements made on image regions that do not contain saturated 
pixels are accurate (unless the image is badly saturated).

Structure A structured light image of parallel laser lines scanned across the 
subject. (Available in the IVIS® Imaging System 200 Series and IVIS 
Spectrum.) The surface topography of the subject is determined from 
the structured light image.

Reference A structured light image of a white plate that is acquired and stored on 
disk prior to instrument installation.

3D View A three-dimensional rendering of the subject. For more details see 
Appendix H, page 247.

Export Opens the Export Active View As Image box so that the active image 
data can be exported (bmp, jpg, png, tiff, or postscript format).

Info Click to display or hide information about the image in the image 
window.
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Figure 5.6  Display modes for a single image
The software coregisters the luminescent and photographic image to generate the overlay image.

Overlay Luminescent

Height Map

Structure Reference

3D View

Photograph

Bias
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Tagging an Image An image tag displays the x,y pixel coordinates of the location, and the pixel intensity 
(z, counts or photons). You can apply a tag at a user-specified location in an image. 

Organizing Images When multiple image windows are open, you can organize them in a cascade or tile 
arrangement.

To apply a tag:

1. Right-click a location in the image. 

2. Select Insert Tag on the short cut menu.

To remove a tag: 

1. Position the pointer over the tag.

2. Right-click the image and select Remove 
Tag on the shortcut menu. 

3. To remove all tags, right-click the image and 
select Remove All Tags on the shortcut menu.

To move a tag: 

1. Position the pointer over the tag.

2. When the hand tool appears , use a click-
and-drag operation to move the tag, then 
click the mouse to set the tag location.
- A line between the pixel and the tag identifies 

the location associated with the tag.

To tile the open 
image windows, 
choose Window → 
Tile on the menu 
bar.
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5.5 Viewing Image Information

At acquisition, the software captures image information that includes all of the text 
information that is associated with every image (for example, camera parameters and 
user labels).

To organize the image 
windows in a 
cascade, choose 
Window → Cascade 
on the menu bar.

Click Info to display the label set information and acquisition information for the image.

Label set 
information 
& 
acquisition 
parameters
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To view information about an image:

1. Open the image or image sequence of interest. (For details on how to open data, 
see page 45).

2. Select View → Image Information on the menu bar.
- The Image Information window appears.

3. To choose an image, make a selection from the Sequences drop-down list and the 
Images drop-down list.

Drop-down list of images in the selected 
sequence. Or a list of single images if 
“Individual Images” is selected in the 
Sequences drop-down list.

Drop-down list of open sequences. 
Choose Individual Images from the 
list to show the open single images 
in the Images drop-down list.

4. To view information of interest, select a category in the upper box to show the 
associated information in the lower box. For example, select luminescent image in 
the upper box to show the luminescent image acquisition parameters.

Choose the Show All 
Sections option to 
display all categories 
of image information.
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Editing the Image 
Label

You can edit the image label information after acquisition.

1. Open an image.

2. Select Edit → Image Labels on the 
menu bar.

3. In the Edit Image Labels box that appears, 
edit the information of interest. You can 
also select a new label set to apply to the 
image or sequence.

4. When you are finished, click OK.
- The image information is updated.

5. Save the image to save the updated image 
information.
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5.6  Image Layout Window

The Image Layout window provides a convenient way to annotate and save an image 
to a graphic file.

Table 5.4  Image layout window

Item Description

Clears the Image Layout window. 

Note: If you do not clear the layout (click the button) before you close the 
Image Layout window, the same window contents are displayed the next 
time the window is opened

Opens a dialog box that enables you to save the Image Layout window 
contents to a graphic file.

Pastes the active image in the Image Layout window.

Copies the contents of the Image Layout window to the system 
clipboard.

Pastes the contents of the system clipboard to the Image Layout 
window.

Rectangle drawing tool

Ellipse drawing tool

Pointer tool

Arrow and line drawing tool

1. To open the Image Layout window, 
select View → Image Layout 
Window on the menu bar.

2. To paste the active image into the 
Image Layout window, click the  
button.

3. To resize the image, drag a handle 
 at a corner of the image.

4. To reposition the image in the 
window, drag the image.
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5.7 Adjusting Image Appearance

Use the image adjust tools to adjust the appearance of an image (Figure 5.7).

NOTE
Not all tools are available for all image display modes.

Select an the item in the Image Layout window. To move the item to the 
front or back in the window, choose an option from the  drop-down list.

Deletes the selected image.

A drop-down list of formatting options for the Image Layout window. For 
example, the 2x2 layout style provides 4 separate layout areas in the 
window. A different image can be pasted into each layout area. 

To apply notes to an image, enter text in the annotation box and press 
Enter. Drag the text to the location of interest in the image.

Opens a dialog box that enables you to select a font or edit the font style 
and size.

Opens a color palette that enables you to select a font color or specify a 
custom font color.

Opens a text editor that enables you to edit the selected text.

Table 5.4  Image layout window (continued)  

Item Description

Figure 5.7  Tool palette, Image Adjust tools 

Image data 
Min & Max

Color bar 
Min & Max

Color bar
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Table 5.5  Image Adjust tools

Item Description

Click this button to incrementally zoom out on the image (reduces the 
image dimensions in the image window). Note: The zoom tools are also 
available in the shortcut menu when you right-click the image (Ctrl-click 
for Macintosh users).

Click this button to incrementally zoom in on the image (incrementally 
magnifies the image in the image window).

Click this button to magnify the area inside a rectangle that you draw using 
a click-and-drag operation. (Sets the dimensions of the magnified area 
equal to image window dimensions.)

Click this button to return the image to the default display magnification.

Click this button to move a magnified image (pan) in the image window. 
For more details, see page 65.

Click this button to hide or display the image min/max information in the 
image window

Click this button to hide or display the color scale in the image window

Click this button to hide or display the color scale min/max information in 
the image window

Photo 
Adjustment

Brightness Click and move the slider left or right to adjust the brightness of an image 
displayed in overlay or photograph mode. Alternatively, enter a brightness 
value.

Gamma Click and move the slider left or right to adjust the gamma of a image 
displayed in overlay mode. Alternatively, enter a gamma value. (Gamma is 
related to image contrast.)

Opacity Click and move the slider left or right to adjust the opacity of the 
pseudocolor luminescent data of an image displayed in overlay mode. 
Alternatively, enter an opacity value.

Color Scale

Min The minimum pixel intensity associated with the color bar for an image. 
Pixels less than the minimum value are not displayed.

Max The maximum pixel intensity associated with the color bar for an image. 
Pixels greater than the maximum value are displayed in the maximum 
color.

Limits

Auto When this option is chosen, the software sets the Min and Max values to 
optimize image display and suppress background noise. The Min and Max 
settings can be manually adjusted to further optimize the image display for 
your needs.

Full Choose this option to set the Max and Min values to the maximum and 
minimum data values in the image.

Manual Choose this option to enter Max and Min values for the image display.

Individual Applies a separate color table to each image in a sequence. Note: This 
option is only available when an image sequence is active.
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Magnifying or Panning 
in the Image Window

To incrementally zoom in or out on an image:

•Click the  or  button. Alternatively, right-click the image and select Zoom In 
or Zoom Out on the shortcut menu.

To magnify a selected area in an image:

1. Click the  button. Alternatively, right-click the image and select Area Zoom on the 
shortcut menu.

2. When the pointer becomes a +, draw a rectangle around the area that you want to 
magnify.
- The selected area is magnified when you release the mouse button.

To reset the magnification (remove magnification):

•Click the  button. Alternatively, right-click the image and select Reset Zoom on 
the shortcut menu.

To pan the image window:

1. Click the  button. 

2. When the pointer becomes a ., click and hold the pointer while you move the 
mouse.

Note: Panning helps you view different areas of a magnified image. If the image has 
not been magnified, you cannot pan the image.

Color Table Click the drop-down arrow to select a color table for the image data. (For 
more details on color tables, see Pseudocolor Images, page 211.)

Reverse Choose this option to reverse the selected color table.

Logarithmic Scale Choose this option to apply a log scale to the relationship between 
numerical data and the color range in the color table. A log scale increases 
the range of meaningful numerical data that can be displayed.

Table 5.5  Image Adjust tools (continued)  

Item Description
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5.8  Correcting or Filtering Image Data

Use the Corrections/Filtering tools (Figure 5.8) to subtract background or apply 
corrections to the image data. (For more details on sources of background, see 
Appendix E, page 217.) You can also apply smoothing and soft binning to the image 
data. (For more information on binning and smoothing, see Appendix C, page 205.)

Figure 5.8  Tool palette, Corrections/Filtering tools

Table 5.6  Tool palette, Corrections/Filtering tools

Tool Description

Read Bias Subtraction/
Dark Charge 
Subtraction

Select this check box to subtract dark background from the image 
data.If a dark charge image is available for the imaging conditions, the 
dark background image, including read bias noise, will be subtracted. 
Otherwise, only read bias noise will be subtracted. For more details on 
background, see Appendix E, page 217. 

Note: In photons mode, dark background subtraction is a mandatory 
default. In counts mode, the check box can be cleared.

Flat Field Correction Select this check box to apply a lens correction factor to the image 
data. For more details on flat field correction, see Appendix D, 
page 216. Note: In photons mode, flat field correction is a mandatory 
default. In counts mode, the check box can be cleared.

Cosmic Correction Select this check box to correct image data for cosmic rays or other 
ionizing radiation that interact with the CCD. For more details on 
cosmic correction, see Appendix D, page 216.

Adaptive FL 
Background 
Subtraction

Opens the Photo Mask Setup box that enables you to set the photo 
mask for adaptive fluorescent background subtraction. For more 
details on adaptive fluorescent background subtraction, see Appendix 
F, page 235.

Binning Specifies the number of pixels in the image data that are grouped 
together to form a larger pixel (called soft binning). Binning changes 
the pixel size in the image (Figure 5.9). For more details on binning, 
see Appendix C, page 206.

Read Bias Subtraction and Flat Field 
Correction are default mandatory 
corrections in photons mode. In counts 
mode, these corrections can be cleared.
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5.9 Image Information Tools

You can view information about the active image using the Image Information tools 
(Figure 5.10). 

Smoothing Computes the average signal of the specified number of pixels and 
replaces the original signal with the average signal (Figure 5.9). 
Smoothing removes signal noise without changing pixel size.

Note: This type of smoothing is defined differently from the 
smoothing performed in the Living Image® software.

Click this button to return the binning or smoothing to the previous 
setting and update the image.

Figure 5.9  Example of binning and smoothing image data

Table 5.6  Tool palette, Corrections/Filtering tools (continued)  

Tool Description

Binning at acquisition = 8, no smoothing Binning = 2, smoothing = 5x5

Figure 5.10  Tool palette, Image Information tools
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Table 5.7  Tool palette, Image Information tools

Tool Description See Page

Click this button to display a histogram of pixel intensity. 70

Click this button to display a line profile. 71

Click this button to display the distance measurement cursor in 
the image window.

72

Click this button to draw and measure a rectangle on an image. 73

Click this button to display/hide a scale on the x and y-axis of the 
image window.

Click this button to display/hide a grid the image window.

Choose the units (cm or pixels) for distance measurements in 
the image window.

Image

Binning The binning applied to the image. Note: If soft binning is applied 
to the image data, and the binning level is changed from 8 to 16, 
the new binning is indicated as 8x2.

69

Image X,Y The x,y pixel coordinates of the mouse pointer location in the 
image.

Image Data The intensity (counts or photons) at the pixel location of the 
mouse pointer.

Crop/Distance

The x,y pixel coordinates at the upper left corner of the crop 
tool.

OR

The x,y pixel coordinates at the “A” end of the distance 
measurement cursor.

73

The x,y pixel coordinates at the lower right corner of the crop 
tool.

OR

The x,y pixel coordinates at the “B” end of the distance 
measurement cursor. 

The width and height of the image crop tool.

OR

Δx, Δy from the A to B end of the distance measurement tool.

Distance The length of the diagonal from corner A to corner B in the 
image crop tool.

OR

The length of the distance measurement cursor.
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Use the tools to make measurements in an image and view pixel data in different 
formats:

Viewing X,Y 
Coordinates & 
Intensity Data

Image Information Description See Page

 x,y coordinates and 
associated intensity

The x,y pixel coordinates of the mouse pointer location in 
the image and the intensity (counts or photons) at that 
location.

69

Histogram Histogram of pixel intensities in an image. 70

Line profile Plots a line graph of intensity data at each pixel along a 
user-specified horizontal or vertical line in the image

71

1. In the Image Information tools, choose Cm or Pixels from the Units drop-down list.

2. Put the mouse pointer over the location of interest in the image.
- The x,y coordinates and intensity data are displayed in the tool palette.

Note: The information is updated when you change the pointer position.
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Viewing an Image 
Histogram

The image histogram plots a frequency distribution of the pixel intensities in an image. 
The software sorts the intensities into groups or bins (x-axis) and plots the number of 
pixels per bin (y-axis). 

Table 5.8  Histogram window

Item Description

Full Displays the histogram using the full intensity range of the image.

Min Bin The lowest intensity bin.

Max Bin The highest intensity bin.

# Bins The total number of bins.

Opens a dialog box that enables you to export the histogram (.csv).

Copies the histogram to the system clipboard.

Opens the print dialog box.

To display the image histogram:

1. Open an image.

2. In the Image Information tools, click the Image 
Histogram button .

Note: By default the Auto min/max range of the image data determines the histogram 
range and bins (the software sets the min and max values to optimize image display 
and suppress background noise). To display the histogram using the full intensity 
range of the image, click Full in the Histogram window.

3. To edit the minimum or maximum bin intensity, enter a new value in the Min Bin 
or Max Bin box, or click the  arrows.

4. To edit the number of bins, enter a new value in the # Bins box or click the  
arrows.

NOTE
In the Overlay display mode, the histogram plots the luminescent data. To obtain a 
histogram of the photograph, select Photograph from the Display drop-down list.
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Viewing a Line Profile The line profile plots intensity (y-axis) at each pixel (x-axis) along a user-specified line 
in the image. The line profile is automatically updated when you change the line 
position.

NOTE
In the Overlay display mode, the line profile plots the luminescent data. To obtain a 
histogram of the photograph, select Photograph from the Display drop-down list.

Table 5.9  Line Profile window

Item Description

Line 
Orientation

Choose Vertical, Horizontal, or Free Hand from the drop-down list to set the 
orientation of the line in the image window. The Free Hand orientation enables 
you to drag each line segment endpoint to a user- selected position.

Width Sets the line width.

To display the line profile:

1. Open an image, and in the Image Information tools, click the Line Profile button .
- A blue line appears on the image and the Line Profile window appears.

2. To view the line profile at another location in the image, put the mouse pointer over 
the line. When the pointer becomes a , drag the line over the image. The blue line 
determines the pixel intensities that are plotted in the line profile graph.
- The line profile is updated as you move the blue line move over the image.
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Making Image 
Measurements

To measure distance with the measurement cursor:

1. Open an image, and in the Image Information tools, click the Distance 
Measurement Cursor button .

- A measurement cursor ( ) appears on the image. The tool palette shows 
the position and length of the cursor.

Position Line position (pixels).

X Min

X Max

Displays the minimum and maximum value of the x-axis. Use the  arrows to 
change the x-axis min or max. If photons is selected in the image window, the 
x-axis units = pixels. If counts is selected in the image window, the x-axis units 
= cm. To display the range available for the Min or Max, place the mouse pointer 
over the Min or Max edit box.

Y Min

Y Max

Displays the minimum and maximum value of the y-axis. Use the  arrows to 
change the y-axis min or max. To display the range available for the Y Min or Y 
Max, place the mouse pointer over the Min or Max edit box.

Click to reset the X and Y Min and Max values to the defaults.

Full Scale Select this option to display the full X and Y-axis scales.

Logarithmic 
Scale

Select this option to apply a log scale to the y-axis.

Enables you to choose the grid line pattern to display in the line profile window. 

Exports the line profile data to a .csv or .txt file.

Copies the line profile graph to the system clipboard.

Opens the Print dialog box.

Table 5.9  Line Profile window (continued)  

Item Description

Measurement cursor
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2. To change the cursor position or size, drag the A or B end of the cursor to a new 
location on the image.
- The measurement information in the tool palette is updated.

3. To hide the cursor, click the  button.

To measure distance using the crop box:

1. Open an image, and in the Image Information tools, click the Image Crop button .

2. When the mouse pointer changes to a +, draw a rectangle on the area of interest.

3. To change the size or position of the crop box, drag a handle  at a corner or side of 
the box.

4. To delete the crop box from the image, click the  button.

Table 5.10  Measurement cursor position & length

Item Description

Pixel x,y coordinates of position A on the cursor.

Pixel x,y coordinates of position B on the cursor.

Length of the cursor from A to B (number of pixels), vertical distance 
from A to B (number of pixels).

Distance Length of the cursor from A to B (number of pixels).

Crop box

Crop box 
position & 
dimensions
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5.10 Rendering Intensity Data in Color

The colorize tool renders luminescence or fluorescence data in color, enabling you to 
see both intensity and spectral information in a single view. The tool provides a useful 
way to visualize multiple probes or scale probe signals that are not in the visible range.

NOTE
The colorize tool is only available if Show Advanced Options is selected in the general 
preferences (see page 196).

To view colorized intensity data:

1. Open an image sequence.

2. Select Tools → Colorize “sequence name”_SEQ on the menu bar.
- The software renders each luminescent or fluorescent image in color and 

combines them into a single image.

Table 5.11  Crop box position & dimensions

Item Description

x,y coordinates at the upper left corner of the box.

x,y coordinates of lower right corner of the box.

Box width and height.

Distance Length of the diagonal from the upper left to lower right corner of the 
box.

In this example, images 
were acquired using 
different combinations of 
excitation and emission 
filters. The samples are 
quantum dot nanocrystals 
(700 or 800 nm).
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Table 5.12  Colorize tools

Item Description

Colorize 

Color Range The color map indicates the color range of the selected camera setup 
from short to long wavelength. The two sliders determine the lower 
and upper limits of the color range that is used to render color. The 
parts of the color map outside the selected range are not used in the 
color rendering process. By default, the entire color range is 
selected.

Filter Range The wavelength range of the luminescent images in the sequence. 
The two sliders determine the lower and upper end of the filter 
range. Only the parts of the image that are within the selected 
wavelength range are colorized. By default, the entire filter range is 
selected.

Color Camera

VIS Regular camera setup that mainly renders color in the visible range. 
It is similar to the color response of a commercial digital camera. NIR 
fluorophores appear dark red to invisible using the VIS camera setup.

NIR A special camera setup that extends the color response into the near 
infrared range. Near infrared fluorophores appear red to purple using 
the NIR camera setup.

Log Scale If this option is chosen, the dynamic range of the brightness in the 
image is compressed using a log scale. This improves the visibility of 
dark areas in the image.

Real Color If this option is chosen, the colors are rendered using the 
wavelengths that directly correspond to the camera setup. For 
example, GFP appears green using real color rendering.

If this option is not chosen, the original wavelength range of the 
image is modified to include the entire visible wavelength range of 
the camera setup. This helps improve the color contrast.

3. To access controls for manually 
adjusting the color rendition, click 
Colorize.
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5.11 Viewing Transillumination Data

The transillumination overview feature combines the images of a FLIT sequence (a 
fluorescence sequence acquired in transillumination mode) into a single image. All of 
the individual fluor signals are stacked over one photograph and the intensity is 
summed. One overview is created per filter pair. If two filter pairs were used during 
acquisition, then two overview images will be created. All transillumination locations 
are displayed simultaneously; a tool tip displays the transillumination position when 
you mouse over a transillumination point.

An overview image is displayed in photon units and can be analyzed using the tools in 
the tool palette.

1. Open a sequence acquired in fluorescence transillumination mode.

2. Select Tools → Transillumination Overview for xx_SEQ on the menu bar.
- The overview appears.

Sequence view Transillumination overview



77

Living Image® Software User’s Manual

5.12  Viewing & Editing Kinetic Data

In the image window, you can:

• Play kinetic data

• Select and view a particular image

• Select a range of images and extract as a separate kinetic data set

Figure 5.11  Image window, kinetic data

Current image number (top slider 
position). To select a particular 
image, enter a new number or 
move the top slider. 

Start frame (image) in the 
selected data range (left 
slider position) 

Current image 

End frame (image) in the selected data 
range (right slider position) 

Use the bottom sliders to select a 
range of data for viewing or export
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Figure 5.12  Image window, selecting kinetic data for export
Put the mouse arrow over a bottom slider to view a tooltip that shows the number of 
selected images (frames)

Table 5.13  Image window, kinetic data

Item Description

 Play Starts playing kinetic data.

 Stop Stops playing kinetic data.

 Edit and Save options Shows or hides the bottom sliders that enable you to select a 
range of data and the Extract button that provides save options for 
the user-selected image or data.

Accumulate If this option is chosen, the software computes and displays the 
cumulative intensity signal. Choose this option and playback the 
kinetic data to visualize accumulations as it happens.

Extract Click to select a save option for the current image or selected 
data.

Extract Current Image Displays the current image in a new image window.The software 
prompts you to save the image when you close the image 
window.

Extract Accumulated 
Image

The software computes the cumulative signal for each image 
(sum of the signal in all images up to and including the current 
image), then displays the cumulative signal of the current image 
in a new image window. The software prompts you to save the 
image when you close the image window.
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Viewing Kinetic Data 1. Open the kinetic data.

2. To start playing the kinetic data, click the  button. If you want to start the playback 
at a particular image, first move the top slider to the starting image, then click the 

 button.

3. To stop playing data, click the  button.

4. To view the cumulative signal during playback, choose the Accumulate option. If 
the accumulated image maximum exceeds the current color scale range, use the 
image adjust tools to adjust the color scale. 

Editing & Exporting 
Kinetic Data

You can select a range of images for export to DICOM format (includes photographs, 
intensity signal, and read bias) or to a movie. 

1. In the image window, click the  button (Figure 5.12). 

2. If you want to select a particular range of data for export, use the frame range 
selection to select the data. Use the left slider to select the start image and the right 
slider to select the end image in the data range of interest. 
- The top slider automatically moves to denote the location of the current image 

with respect to the selected data range. 

3. To export the selected data to a movie:
a.Click Extract and choose Save as a Movie.

b. In the dialog box that appears, select a folder, enter a name for the movie, and choose 
the file format (for example, .mpg4).

Extract Kinetic Data Choose this option if you want to save a particular range of 
images. Opens the Browse For Folder dialog box that enables you 
to select where to save the selected data. 

Table 5.13  Image window, kinetic data (continued)  

Item Description
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Exporting an Image 
from a Kinetic Data Set

1. To select an image, move the frame slider or enter a frame number in the spin box.

2. Click Extract and choose Extract Current Image.
- A new image window appears and displays the selected image.

3. To save a snapshot of the current image, click the Export Graphics button  in the 
image window. In the dialog box that appears, select a destination folder, enter a 
file name, select a file type, and click Save.

Figure 5.13  Image window, selecting an image for export

Spin box

Export Graphics button
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6 Working With ROI Tools
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6.1 About ROIs

A region of interest (ROI) is a user-specified area in an image (Figure 6.1). The ROI tools 
enable you to create three types of ROIs: measurement, average background, or subject 
ROI (Table 6.1). During a session, the Living Image® software records information about 
the ROIs you create and computes statistical data for the ROI measurements. The ROI 
Measurements table displays the data and provides a convenient way to review or export 
ROI information (Figure 6.1). (For more details, see Managing the ROI Measurements 
Table, page 106.)

Figure 6.1  Example measurement ROIs and ROI measurements table

ROI Measurements table
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NOTE
For a quick guide to drawing a measurement ROI, see page 84. 

6.2 ROI Tools

Table 6.1  Types of ROIs

Type of ROI

Measurement ROI Average Background ROI Subject ROI

Description

Measures the signal 
intensity in an area of an 
image. 

Measures the average signal intensity 
in a user-specified area of the image 
that is considered background. 

Note: Using this type of ROI is optional. 
If the animal has significant 
autoluminescence or autofluorescence, 
you can determine a background-
corrected signal in a measurement ROI 
by subtracting an average background 
ROI from a measurement ROI. 

Identifies a subject animal in an 
image. 

Note: Using this type of ROI is 
optional. It provides a convenient 
way to automatically associate (link) 
a measurement and average 
background ROI for background-
corrected ROI measurements when 
there is significant 
autoluminescence or 
autofluorescence. 

Available ROI 
Drawing Methods 

• Manual 
• Automatic
• Free draw 

• Manual
• Free draw 

• Manual 
• Automatic
• Free draw

Available Shapes Circle, square, grid, or 
contour

Circle or square Square

To display the ROI tools:

1. Open an image or image sequence and click ROI Tools in the tool palette.

ROI 
tools
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Table 6.2  Tool palette, ROI tools

Item Description

Click to select the number of circle ROIs to add to the active image. 

Click to select the number of square ROIs to add to the active image.

Click to specify the grid pattern for a measurement ROI that you want to add 
to the active image. This tool is useful for an image of a multi-well culture 
plate or microtiter plate.

Click and select Auto All to automatically draw ROIs in the image using the 
auto ROI parameters. Click and select Auto 1 to automatically draw one ROI 
at a user-selected location using the auto ROI parameters. For more details 
on using the auto ROI features, see page 88.

Click to display the ROI Measurements table or compute intensity signal in an 
ROI.

Click to display a drop-down list of options to delete an ROI(s) in the active 
image. For more details, see page 105.

Note: These commands do not delete the ROIs that are saved to the system 
(listed in the Menu Name drop-down list).

Apply to 
Sequence

Choose this option to apply the selected ROI to all images in a sequence.

Type Choose the ROI type from the drop-down list: 

Measurement - Measures the signal intensity in an area of an image.

Average Bkg - Measures the average signal intensity in a user-specified area 
of the image that is considered background.

Subject ROI - Identifies a subject animal in an image. The software 
automatically associated a measurement and average bkg ROI included in the 
same subject ROI. Using this type of ROI is optional.

Save ROIs

Name The name of the selected ROI set or the default name for a new ROI set.

Delete Deletes the selected ROI set from the system. Note: This permanently 
removes the ROI from the system.

Load Applies the ROI set selected from the Name drop-down list to the active 
image.

Save Saves the ROI set in the active image. 

Note: This is a global save (the ROI is saved to the system) and the ROI set 
can be loaded onto any image. If you use the File ➞ Save commands to save 
an image that includes an ROI, the ROI is saved with the image only (not a 
global save) and is not available for loading onto other images. For more 
details, see Saving ROIs, page 104.

Auto ROI 
Parameters

Parameters that specify how the auto ROI tool draws an ROI. Note: These 
are advanced options that are only available if “Show Advanced Options” is 
selected in the general preferences.

Threshold % If the Auto All or Auto 1 method is selected, the Threshold % specifies the 
minimum per cent of peak pixel intensity that a pixel must have to be included 
in an ROI identified by the software.

Note: After ROIs are drawn on an image, if you modify the Threshold% (move 
the slider or enter a new value) the software automatically updates the ROIs.



6. Working With ROI Tools

84  

6.3 Measuring ROIs in an Image

To obtain the intensity signal in a user-specified area of an image, draw a measurement 
ROI on the image. There are three ways to draw measurement ROIs:

Quick Guide: Drawing a 
Measurement ROI on 
an Image or Image 
Sequence

These steps provide a quick guide on how to apply a measurement ROI to an image or 
image sequence. For more details about measurement ROIs, see page 84.

1. Open an image or image sequence and click ROI Tools in the tool palette.

Lower 
Limit

Specifies a multiple (1 to 10) of the color bar minimum that sets the lower 
threshold for identifying an ROI. For example, if the lower limit = 2 and the 
color bar minimum = 1000 counts, then the auto ROI tool will only draw an 
ROI on areas of 2000 counts or greater. This helps create ROIs only in the 
visible range.

Minimum 
Size

Sets the minimum size of an ROI (measured in pixels). For example if the 
minimum size is set at 50, then ROIs created on the image must be greater 
than 50 pixels in size.

Preview If this option is chosen, the software draws the ROI each time a parameter is 
changed. ROI parameters can be saved without drawing the ROI.

Use Bkg 
Offset

Choose this option to measure background-corrected signal. For more details, 
see page 91.

Replace 
ROIs

If this option is chosen, all auto ROIs are replaced when new ROI(s) are 
created.

Restore 
Defaults

Restores the factory-set defaults for the auto ROI parameters.

Save/Load Click to display or hide the tools that enable you to save, load, or delete auto 
ROIs in the active data. Note: The save function saves parameters, the not 
actual ROIs. This means that when you load saved auto ROI parameters, the 
software draws a new ROI using the saved values (Threshold%, Lower Limit, 
Minimum Size).

Table 6.2  Tool palette, ROI tools (continued)  

Item Description

Drawing 
Method Description See 

Page

Manual Places one or more ROIs (circular, square, or grid shape) on the image. 84

Automatic The software automatically locates and draws a contour ROI(s) on the 
image. To do this, the software locates the peak pixel intensities in the 
image and searches the neighborhood around a peak pixel. A pixel is 
included in the ROI if the pixel intensity is greater than the threshold%, 
a user-specified percentage of the peak pixel intensity.

88

Free draw Draw line segments that define the ROI. 90
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NOTE
After the ROIs have been created, right-click an ROI to view a shortcut menu of ROI 
commands (Ctrl-click for Macintosh users). The shortcut menu provides easy access 
to many functions for managing ROIs and viewing ROI properties.

5. To show the ROI Measurements table, click the Measure button  in the tool 
palette.

2. In the ROI tools, select Measurement ROI from the Type drop-down list.

3. Click the Contour button . For an image or image sequence, select Auto All from 
the drop-down list. For kinetic data, select Kinetic ROI.

- The software automatically draws measurement ROIs on the image. The ROI 
label shows the total intensity in the ROI. If you are working with a sequence, 
open an image to view the intensity label. For more details, see page 84.

4. If it is necessary to adjust the 
ROI boundaries, change any of 
the auto ROI parameters (use 
the slider or  arrows):

• Threshold % - Specifies the minimum per cent of peak pixel intensity that a pixel 
must have to be included in an ROI identified by the software



6. Working With ROI Tools

86  

The ROI Measurements tab displays data for all ROIs created in images or sequences 
during a session (one ROI per row). The table provides a convenient way to review and 
export ROI data. For more details on the table, see Managing the ROI Measurements 
Table, page 106.

Manually Drawing a 
Measurement ROI

1. Open an image or image sequence, and in the ROI tools, select Measurement ROI 
from the Type drop-down list.

2. To specify the ROI shape:
a. Click the Circle , Square , or Grid button . 

The grid shape is useful for drawing a grid of ROIs on an image of a well plate.

b. On the drop-down list that appears, select the number of ROIs that you want to add to 
the image or the grid ROI dimensions. 

- The ROI(s) and intensity label(s) appear on the image. If you are working with a 
sequence, open an image to show the ROI intensity.

3. Adjust the ROI position:
a. Place the mouse pointer over the ROI. When the pointer becomes a , click the 

ROI.

b. Drag the ROI.

4. Adjust the ROI dimensions:
a. Place the mouse pointer over the ROI. When the pointer becomes a , click the 

ROI.

b. Place the mouse pointer over an ROI handle  so that it becomes a . Drag the handle 
to resize the ROI.
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NOTE
You can also change the ROI position or size using the adjustment controls in the ROI 
Properties box (see Moving an ROI, page 100 and Editing ROI Dimensions, 
page 101).

5. Click the Measure button . 
- The ROI measurements and table appear. For more details on the table, see 

Managing the ROI Measurements Table, page 106.

Note: For information on how to save ROIs, see page 104.
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Automatically Drawing 
Measurement ROIs

The Living Image® software can automatically identify all of the ROIs in an image or 
image sequence that meet the auto ROI parameter thresholds or draw one ROI at a user-
specified location.

To automatically draw all ROIs detected by the software:

1. Open an image or image sequence, and in the ROI tools, select Measurement ROI 
from the Type drop-down list.

2. Click an ROI shape button (Circle , Square , or Contour ) and select Auto 
All from the drop-down list. 

- The ROIs appear on the image or thumbnails.

3. Click the Measure button . 
- The ROI table appears. For more details on the table, see Managing the ROI 

Measurements Table, page 106.
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4. Double-click a thumbnail to view the 
ROI measurements in the image.

To automatically draw an ROI at a user-specified location:

1. Open an image.

2. Click an ROI shape button and select 
Auto 1 from the drop-down list.

- The create tool appears on the 
image.

3. Use the ring  to move the create 
tool to the location for the ROI.

4. Click Create on the ring tool.
- The ROI appears on the image and 

the ROI label displays the 
intensity signal.

5. To draw another ROI, repeat step 3 
to step 4.

Note: For information on how to save 
ROIs, see page 104.
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Drawing an ROI Using 
the Free Draw Method

Drawing a Subject ROI A subject ROI identifies a subject animal in an image. It provides a convenient way to 
automatically associate (link) a measurement and average background ROI for 
background-corrected ROI measurements when there is significant autoluminescence 
or autofluorescence. (For more details on background-corrected ROI measurements, 
see page 91.) Using a subject ROI is optional.

To draw a subject ROI using the auto ROI feature:

1. Select Subject ROI from the Type drop-down list.

2. Click the  button. 

3. Select Auto All.

1. Open an image, and in the ROI tools, select the type of ROI that you want to draw 
from the Type drop-down list.

2. Click an ROI shape button (Circle , Square , or Contour ) and select Free 
Draw from the drop-down list. In this example, the Contour shape  was selected 
for the free draw method. 
Note: The ROI shapes that are available depend on the type of ROI selected.

3. If you selected:
 or  - Use the pointer (+) to draw the ROI.

 - Use the pointer (+) to click around the area of interest and draw line segments 
that define the ROI. Right-click when the last point is near the first point in the ROI.
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To manually draw a subject ROI:

1. Select Subject ROI from the Type drop-down list.

2. Click the  button, and select 1. 

3. Position the subject ROI so that it includes the measurement ROI(s) and the 
associated average background ROI.

6.4 Measuring Background-Corrected Signal

If a subject has significant autoluminescence or autofluorescence, you can obtain a 
background-corrected ROI measurement by subtracting an average background ROI 
from a measurement ROI. The software computes:

Background-corrected intensity signal = Average signal in the measurement ROI - 
Average signal in the average background ROI

The Image Adjust tools and zoom feature are helpful for selecting an appropriate area 
for an ROI. By setting the image minimum close to zero and zooming in on a 
background area in the image, you can determine where naturally occurring background 
luminescence or autofluorescence is present. For more details on the Image Adjust tools 
and the zoom feature, see Image Layout Window, page 62 and Magnifying or Panning 
in the Image Window, page 65.

To measure background-corrected signal:

1. Draw one or more measurement ROIs on the subject. (For more details, see 
page 90.)

2. Draw an average background ROI on the subject:
a. Select Average Bkg ROI from the Type drop-down list.

b. Click the Square  or Circle  button and select 1.
- The ROI is added to the image.

For more details on adjusting the ROI position or dimensions, see page 100 and 
page 101.

Note: The average background ROI and measurement ROI do not need to be the 
same shape or size because the software computes the average intensity signal in 
each ROI.

3. Use one of the following three methods to associate the average background ROI 
with one or more measurement ROIs.
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Method 1
Draw a subject ROI that 
includes the measurement 
ROI and the average 
background ROI. For details 
on how to draw a subject ROI, 
see page 90.

Method 2
Right-click the measurement 
ROI and select Set BkG ROI 
to Bkg X on the shortcut 
menu that appears.
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Method 3:

1. Right-click a background ROI and select Properties on the shortcut menu.

2. In the ROI Properties box that appears, click the Bkg ROI tab and put a check mark 
next to Use as BKG for future ROIs in.

3. Choose the image name or the Entire sequence option.
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6.5  Measuring ROIs in Kinetic Data

Kinetic ROIs help you track signal sources on an unanesthetized, mobile subject. The 
software automatically creates a separate ROI in each frame based on the user-specified 
auto ROI settings. As a result, kinetic ROIs are continuously displayed during kinetic 
data playback. You can draw a kinetic ROI using any of the methods or shapes in Table 
6.1, page 82.

NOTE
Large kinetic data sets may require more time to create, plot, and measure the ROIs 
because the software first applies corrections to a frame (specified in the Corrections/
Filtering tool palette), then draws the ROIs in the frame. The process can be aborted 
at any time.

Quick Guide: Drawing a 
Kinetic ROI

These steps provide a quick guide on how to apply a measurement ROI to kinetic data. 
For more details about measurement ROIs, see page 84.

1. Open the kinetic data and click ROI Tools in the tool palette.

2. In the ROI tools, select Measurement ROI from the Type drop-down list.

3. Click the Contour button  and select Kinetic ROI.

- The create tool appears on the image.

4. Use the ring  to move the create tool to the area of the ROI.

NOTE
When drawing kinetic ROIs on kinetic data with multiple sources, it is recommended 
that you start with the brightest source, then the next brightest, and so on in order to 
create ROIs that can be distinguished based on the signal strength.
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wavelength data adds to the analysis. The recommended wavelengths are 580-640 nm for 
tissue and 560-620 nm for the Xenogen XPM-2 tissue phantom.

Minimum Radiance

The minimum radiance determines the lower radiance [photons/sec/cm2/sr] threshold of 
the data to be used in the DLIT/FLIT analysis.

The software automatically computes a default minimum radiance value and this is the 
recommended starting point for an analysis. If too much noise is included in the 
analysis, increase the minimum radiance value. 

An optimum minimum radiance value can be evaluated by viewing the image data in 
photon units (photons/sec/cm2/sr) and adjusting the color bar Min to be above the level 
of noise in the image.

Parameters Tab

Angle Limit

The angle limit refers to the angle between the object surface normal and the optical 
axis. The optical axis can be considered to be a line perpendicular to the stage. The 
surface normal is a line perpendicular to a plane tangent to the surface point. For 
example, in a dorsal view of a mouse, the highest point on its back would have a normal 
line perpendicular to the stage. In this case the angle is zero. The side of a mouse 
abdomen would have a normal line parallel to the stage, so the angle here would be close 
to 90° .

The software uses luminescent image data for surface elements that are less than the 
angle limit. The default angle limit setting is 70°  for the IVIS® Imaging System 200 

Figure H.6  3D reconstruction tools, Parameters tab, DLIT (left) and FLIT (right)
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Series or the IVIS Spectrum. For IVIS Spectrum or 200 Series data, if there is 
significant signal on the side of the subject, a larger angle of 70-85°  can be used.

Kappa Limits (DLIT)

Kappa (κ) is a parameter that is searched during a reconstruction to determine the best 
fit to the image data. Small values of kappa tend to favor deeper sources, while large 
values favor more shallow sources.

The limits on kappa are minimum of 0.1 and a maximum of 10. The default range for 
kappa is 0.5-4. Kappa is doubled at each iteration, so for a selected range of 0.5-4, the 
kappa values for each iteration would be 0.5, 1, 2. and 4. Choosing a large range for 
kappa produces the most reliable solution, but requires more analysis time.

N Surface (FLIT)

The number of surface intensity points to use in the reconstruction at a given source 
position. 

N Surface Limits (DLIT)

This is the maximum number of surface intensity points to use in the reconstruction at 
a given wavelength. The range is 200 to 800 and the default is 200. The time required 
for reconstruction is shortest for smaller values of N (for example, 200). However, a 
large N value may give a more accurate result because more data are included in the fit.

Starting Voxel Size (FLIT)

Voxels are the small cubes of space inside a subject, each of which contains a quantity 
of fluorescent yield. The FLIT reconstruction begins with large voxels, specified by the 
starting voxel size (the length of a voxel cube side in mm). At each iteration, the 
algorithm reduces the size of the voxels by a factor of 2 until the optimum solution is 
determined.

Starting Voxel Size Limits (DLIT)

Voxels are the small cubes of space inside a subject, each of which contains a light 
source (much like a pixel in a 2D image). The DLIT reconstruction begins with large 
voxels, specified by the voxel size limit (the length of a side of the voxel cube in mm). 
At each iteration, the algorithm reduces the size of the voxel by a factor of two until the 
optimum solution is found.

The voxel size limits are a minimum of five and a maximum of 10. The default range 
is set to 6-9 mm. A larger range of voxel limits ensures a more reliable solution, but 
requires more computational time.

Voxel Size Increment (DLIT)

This is the step increment in voxel size, stepping from the minimum voxel size limit to 
the maximum voxel size limit. For example, if the voxel size limit ranges from 6-9 mm, 
a voxel size increment = 1 gives four starting voxel sizes (6, 7, 8, and 9 mm).

The default increment of 1 mm is usually adequate, however smaller increments can be 
used if you want to sample finer voxel sizes. Smaller increments will significantly 
increase the time required for reconstruction.
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Background (FLIT)

Choose this option to take the background fluorescence (for example, autofluorescence 
or non-specific probe in circulation) into account. Background fluorescence and 
fluorophore emission contribute to the photon density signal at the surface. The 
background fluorescence signal is modelled in order to isolate the signal due to the 
fluorophore only, where an average homogenous tissue background fluorescence yield 
is determined empirically.

Background fluorescence contribution to the photon density at the surface is forward-
modelled. Simulated photon density data due to background at the surface is subtracted 
from the measured photon density so that the subsequent photon density used in the fit 
consists only of signal that is associated with the fluorophore.

The background option specifies whether or not the background fluorescence should be 
fit. This is not necessary for the XFM-2, long wavelength data. It is important when 
there is non-specific dye in circulation or a lot of autofluorescence. 

Uniform Surface Sampling

If this option is chosen, the surface data for each wavelength will be sampled spatially 
uniformly on the signal area. If this option is not chosen, the maximum ‘N surface 
elements’ will be sampled for the data. This means that the N brightest surface elements 
will be used as data in the reconstruction. Typically, non-uniform sampling is 
recommended if there is a single bright source, while uniform sampling is preferred if 
there are several scattered sources.

NNLS Optimization + Simplex Optimization (DLIT)

If NNLS Optimization + Simplex option is chosen, the software uses a linear 
programming algorithm to seed the solution, followed by the NNLS optimization.

NNLS Weighted Fit

Choose this option to weight the data in the NNLS optimization.
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Appendix I   IVIS® Syringe Injection System
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The IVIS Syringe Injection system is designed for use with the IVIS Kinetic Imaging 
System. You can control the infusion pump in the Living Image software or manually. 

For more details on the setup and manual control of the infusion pump, see the IVIS 
Syringe Injection System instructions from Caliper or the PHD 22/2000 Syringe Pump 
Series User’s manual from Harvard Apparatus. Both are included on the Living Image 
3.2 installation CDROM. 

The IVIS Syringe Injection system can be used during kinetic or still image acquisition; 
however, subjects must remain immobile.

I.1 Controlling the Infusion Pump

After the IVIS Kinetic imaging system is initialized and locked, you can access the 
infusion pump controls.

1. Select Acquisition → Infusion Pump Setup on the menu bar.

— The Infusion Pump control panel appears above the IVIS acquisition control 
panel.

NOTE
If you are going to acquire kinetic data, open the infusion pump control panel before 
you open the kinetic acquisition control panel. When the kinetic control panel is open, 
the Acquisition menu is unavailable.
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2. Set the volume and flow rate. 

3. Make a selection from the Syringe Type drop-down list (the associated syringe 
diameter is automatically entered).

To enter a custom syringe:

a. Select Custom from the drop-down list.

b. Click OK in the dialog box that appears.

c. Enter the syringe diameter in the infusion pump control panel. 

NOTE
Custom syringe information that is entered in the infusion pump control panel is not 
saved to the system.

4. To automatically start the infusion pump after data acquisition begins, choose Auto 
Start After and enter the amount of seconds. For example, enter 10 to start infusion 
10 seconds after acquisition begins.

To manually start infusion, click Start Now.

5. To automatically stop infusion, choose Auto Stop After Acquisition. To manually 
stop infusion at any time, click Stop Now.

If the auto stop option is not chosen and you do not manually stop the pump, the 
pump continues to run after acquisition ends.

NOTE
The information in the infusion pump control panel is saved in the click info file. During 
acquisition, if you start infusion, then manually stop and restart the infusion, only the 
last actual start and stop is saved to the click info file, not the start/stop settings in the 
panel.
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I.2  Tracking Infusion in the Maximum vs. Time Graph

During kinetic acquisition, the blue shaded region in the Max vs. Time graph indicates 
the infusion period. During acquisition, if you start infusion, then manually stop and 
restart infusion, only the last actual start and stop is recorded in the Maximum vs. Time 
graph. The graph stops recording infusion when acquisition stops (even though the 
pump may not be stopped).

I.3 Closing the Infusion Pump Control Panel
1. Close the kinetic control panel.

2. Click Acquisition → Infusion Pump Setup on the menu bar.

— The check mark is removed and the panel closes. 
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Appendix J   Menu Commands, Tool Bar, & Shortcuts

Figure J.1  Living Image toolbar

Table J.1  Menu bar commands and toolbar buttons

Menu Bar Command Toolbar 
Button

Description

File ➞ Open Displays the Open box so that you can select and open an image data file.

File ➞ Browse Displays the Browse For Folder box so that you can select and an image data 
folder. The selected folder is displayed in the Living Image browser.

File ➞ Browse Biotrue Opens the Biotrue® CDMS Browser. Note: The browser is only available if the 
system includes the Biotrue CDMS option.

File ➞ Save Saves (overwrites) the active image data.

File ➞ Save As Displays the Browse For Folder box so that you can specify a folder in which to 
save the image data. The original data is not overwritten.

File ➞ Import ➞Organ Atlas Opens a dialog box that enables you to import an organ atlas (.atlas).

File ➞ Import ➞ DICOM Opens a dialog box that enables you to import .dcm image data that can be 
viewed in the Living Image software.

File ➞ Import ➞ 3D Mesh Opens a dialog box that enables you to import a mesh (.xmh). Note: This 
command is only available if an appropriate sequence is active (DLIT or planar 
spectral imaging sequence).

File ➞ Import ➞ 3D Volume Opens a dialog box that enables you to import a source volume (voxels, .xsc). 
Note: This command is only available if an appropriate sequence is active (DLIT 
or planar spectral imaging sequence).

File ➞ Export DICOM Opens the Browse for Folder dialog box that enables you to export the active 
image data to DICOM format (.dcm).

File ➞ Export ➞ 3D Mesh Opens a dialog box that enables you to save the 3D mesh of the active data in 
Open Inventor format (.iv).

File ➞ Export ➞ 3D Volume Opens a dialog box that enables you to save the voxels from the active data in 
Open Inventor format (.iv). 

File ➞ Print Displays the Print box.

File ➞ Print Preview Displays the Print Preview box that shows what will be printed.

File ➞ Recent Files Shows recently opened data sets. Note: The number of files displayed can be 
set in the Preferences box (select Edit ➞Preferences and click the Customize 
tab).

File➞ Exit Closes the Living Image software.
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Edit ➞ Copy Copies the active image window to the system clipboard.

Edit ➞ Image Labels Opens the Edit Image Labels dialog box that enables you to edit the label set 
information for the active data.

Edit ➞ Preferences Opens the Preferences box.

View ➞ Tool Bar Choose this option to display the toolbar.

View ➞ Status Bar Choose this option to display the status bar at the bottom of the main window.

View ➞ Activity Window Displays the Activity window at the bottom of the main application window. The 
Activity window shows a log of the system activity.

View ➞ Tool Palette Choose this option to display the tool palette.

View ➞ Activity Window Choose this option to display the activity bar at the bottom of the main window. 
The activity bar lists a history of the recent software activities.

View ➞ Image Information Displays the Image Information box that shows the label set and image 
acquisition information for the active data.

View ➞ ROI Properties Displays the ROI Properties dialog box.

View ➞ ROI Measurements Displays the ROI Measurements table.

View ➞ Image Layout Window Opens the Image Layout window that enables you to paste an image of the 
active data in the window. 

View ➞ Acquisition Control 
Panel

Displays the control panel.

Tools ➞ Image Math for... Opens the Image Math window for the active data.

Tools ➞ Image Overlay for... Opens the Image Overlay window for the active data.

Tools ➞ Colorize xx_SEQ Opens the Colorized View tab for the active sequence. Note: This menu item is 
only available if “Show Advanced Options” is selected in the Preferences.

Tools ➞ Transillumination 
Overview

Combines the images of a FLIT sequence into a single image (intensities are 
summed) that can be analyzed using tools in the tool palette.

Acquisition ➞ Background ➞ 
Replace

Opens a dialog box that enables you to select an instrument luminescent 
background. This background measurement is subtracted from luminescent 
images.

Acquisition ➞ Background ➞ 
View Available Dark Charge

Opens a dialog box that enables you to view the dark charge measurements for 
the system.

Acquisition ➞ Background ➞ 
Clear Available Dark Charge

Opens a dialog box that enables you to remove the dark charge measurements 
from the system.

Acquisition ➞ Background ➞ 
Measure

Opens a dialog box that enables you to acquire a dark charge measurement.

Acquisition ➞ Fluorescent 
Background ➞ Add or Replace 
Fluorescent Background

Opens a dialog box that enables you to select an instrument fluorescent 
background measurement for the active image data. If the Sub Fluor Bkg option 
is chosen in the control panel, the background measurement is subtracted from 
the image data.

Acquisition ➞ Fluorescent 
Background ➞ Measure 
Fluorescent Background

Starts a measurement of the instrument fluorescent background.

Acquisition ➞ Fluorescent 
Background ➞ Add or Replace 
Fluorescent Background

Opens a dialog box that enables you to select a fluorescent background 
measurement.

Table J.1  Menu bar commands and toolbar buttons (continued)  

Menu Bar Command Toolbar 
Button

Description
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Acquisition ➞ Fluorescent 
Background ➞ Clear Available 
Fluorescent Background

Opens a dialog box that enables you to remove the fluorescent background 
measurements from the system.

Acquisition ➞ Fluorescent 
Background ➞ View Available 
Fluorescent Background

Opens a dialog box that displays the fluorescent background measurements for 
the system. If a fluorescent background is selected, the Sub Fluor Bkg option 
appears in the control panel. Choose the Sub Fluor Bkg option to subtract the 
user-specified background measurement from the image data.

Window ➞ Close Closes the active image window.

Window ➞ Close All Closes all image windows.

Window ➞ Cascade Organizes the open image windows in a cascade arrangement (see page 59).

Window ➞ Tile Organizes the open image windows in a tiled arrangement (see page 58).

Window ➞ 1. xx

Window ➞ 2. xx

Window ➞ etc.

A list of the open data. Select the data of interest to it the active window and 
display it on top of all other open windows.

Window ➞ Other Windows ➞ 
Browser Window

If the Living Image browser is open, makes it the active window and displays it 
on top of all other open windows.

Help ➞ User Guide Displays the online help.

Help ➞ About Living Image Displays the online help index.

Click this button, then click an item in the user interface to display information 
about the item.

Table J.1  Menu bar commands and toolbar buttons (continued)  

Menu Bar Command Toolbar 
Button

Description

Table J.2  Keyboard shortcuts

Keys Shortcut Description

Ctrl + B Opens the Living Image browser.

Ctrl + C Copies the active image to the system clipboard.

Ctrl + D Arranges open windows in a cascade.

Ctrl + O Displays a dialog box that enables you to open data.

Ctrl + P Open the Print dialog box.

Ctrl + S Saves the active file or window.

Ctrl + T Tiles the open windows.

Ctrl + W Closes the active window.

Shift + F1 Changes the mouse pointer to the “What’s This” tool . 

Click this button, then click an item in the user-interface to display information about the item.



J. Menu Commands, Tool Bar, & Shortcuts

264  

[This page intentionally blank.]



265

Living Image® Software User’s Manual

Index

Numerics
3D fluorescent sources 156–157
3D image

rotate or move 166
3D luminescent sources 152–155
3D perspective 169
3D reconstruction

fluorescent sources 156–157
parameters & options 252–255

3D reconstruction results 158–160
3D tools 162–187

Animation tab 182–183
Mesh tab 170–171
Organs tab 175–176
Volume tab 172–173

A
accumulate signal 38, 40
acquire

image sequence 31–32
kinetic data 37
single bioluminescence image 15–18
single fluorescence image (epi-illumination) 18–19
single fluorescence image (trans-illumination) 

19–22
adaptive fluorescent background subtraction 235
adjusting image appearance 63
angle limit 253
animation 182–187

custom 185–186
edit an animation setup 186–187
preset 184–185

auto exposure feature 12
autofluorescence 91, 229

miscellaneous material 231–233
See tissue autofluorescence.
subtract using background filters 236–237
well plate 230–231

autoluminescence 91
automatically draw ROIs 88–89
average background ROI 82, 91

B
background

adaptive fluorescent background subtraction 235
fluorescent 229–235
light on sample 218–220
tissue autofluorescence 236–237

background light
from sample 220–222
on sample 218–220

background-corrected signal 91–93
band gap 226
bandpass filter 225
binning 66, 67, 206–208
bioluminescence image 15–18
browse image data 45–46
browser 46

C
Caliper Corporation

technical support 3
cascade images 58
color table 211
colorize data 74–75
composite image 112–115
control panel 12, 191–194
conventions 2
copy

ROI measurements 107
correction/filtering tools

binning 66
cosmic correction 66
dark background subtraction 66
flat field correction 66
smoothing 67

cosmic correction 66
cosmic ray corrections 216
counts 213
crop box 73

D
dark background subtraction 66
dark charge 218
dark current 217
data

graphic image 211
scientific image 211
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detection efficiency 205
detection sensitivity

adjusting the lens aperture 205
exposure time 206
field of view 206

DICOM file 33, 35
size limit 43

diffusion model 240
display modes 56
display units

counts 213
efficiency 215
photons 214

DLIT
troubleshooting 189

DLIT results 158–160
manage 187

drift correction 217

E
edit

image sequence 29–31
edit image sequence 52–53
efficiency 215, 225, 228–229
electronic background

dark charge 218
dark current 217
drift 217
read bias 217

EM gain 40
export image data 35
exposure time 206

F
f/stop

fluorescent imaging 228
field of view 206
filter

bandpass 225
fluorescent 226

filter spectra 225
flat field correction 66
flat fielding 216
FLIT

troubleshooting 189
FLIT results 158–160

manage 187

fluorescence
adaptive background subtraction 235
reconstruct 3D sources 156–157

fluorescence efficiency 228–229
fluorescence image (epi-illumination) 18–19
fluorescence image (trans-illumination) 19–22
fluorescence imaging components 223–225
fluorescent filters 226
fluorescent imaging

efficiency 225
f/stop 228
normalization 225

focus manually 34
FOV settings 194

G
graphic image data 211

H
High Reflectance Hemisphere 219
histogram 70

I
image

adjusting appearance 63
cascade 58
correct or filter 66–67
correcting/filtering tools 66–67
histogram 70
image window 55–56
information 59
label 61
line profile 71
magnify or pan 65
measurements 72
pixel data 69
tag 58
thumbnails 51
tile 58

image analysis tools 8
image data

browse 45–46
colorize 74–75
export 35
open 47–49
save manually 34

image information 67–68
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image layout window 62–63
image math 112–115
image overlay tool 118–120
image sequence 51–53

acquire 31–32
analyses 8
application-specific 23
create from individual images 53–54
edit 29–31, 52–53
imaging wizard 24–26
manual setup 26–28

image window 17
3D perspective 169
display modes 56

image window (single image) 55–56
imaging & image analysis

example workflow 7
overview 5–8

imaging wizard 24–26
index of refraction 159
information about an image 59
infusion pump 257
infusion syringe injection system

control panel 258
infusion pump 257

initialization
See system initialization.

instrument fluorescent background
background

instrument fluorescent background 235
IVIS Imaging System

fluorescence imaging components 223–225

K
kappa 159
kappa limits 159, 254
kinetic

acquisition settings 39
acquisition window 38

kinetic data
acquire 37
save 43, 44
view and edit 42

kinetic ROI
plot 95
draw 95, 94

L
lens aperture 205
line profile 71
Living Image browser 46
Living Image software

starting 9
luciferase spectrum 241
luminescence

reconstruct 3D sources 152–155

M
magnify image 65
manual

focusing 34
save data 34

manual conventions 2
maximum vs time graph

tracking infusion 259
maximum vs. time graph 41
measurement ROI

automatically draw 88–89
measurement ROIs 82, 84–89

free draw 90
measurements 72
menu commands 261
mesh

drawing style 167
lighting style 167

miscellaneous material autofluorescence 231–233
multiple reporters per photograph 118–120

N
N surface limits 159, 254
NNLS

optimization 159, 255
weighted fit 159, 255

normalization 225

O
open image data 47–49
optical density 226
optical properties for planar spectral imaging 241
organ atlas 181
organs 176–180
overlay 212
overlaying images 118–120
overview
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imaging & image analysis 5–8

P
pan image 65
PCA biplot 136
PCA explained variance 137
photon density 160
photon density map

measured 160
simulated 160

photon radiance 214
photons 214
pixel 211
pixel data 69
planar spectral analysis

optimizing precision 245
planar spectral image analysis 121–123
planar spectral imaging 239–245

diffusion model 240
intensity graph 125
linear fit graph 125
luciferase spectrum 241
optical properties 241
results 124
tools 123–124

point source fitting 143–147
results 148–149
tools 143–146

preferences 195–203
pseudocolor image 211

R
radiance

photon 214
radiance units 214
read bias 217
reconstruct 3D fluorescent sources 156–157
reconstruct 3D luminescent sources 152–155
reduced Chi2 159
ROI 81

automatically draw 88–89
background-corrected signal 91–93
delete 105
edit dimensions 101
edit position 101
free draw 90
managing 97

manually draw 86–87
measurement ROI

free draw 90
measurement ROIs 84–89
Measurements table 86
move 100
move or edit label 103
quick guide 84
ROI line 102
save 104
subject 90
tools 82–83

ROI (kinetic)
quick guide 94, 95

ROI Measurements table 106–108
configure 108–110
copy or export 110

ROI properties 97–99
ROI types

average background 82, 91
measurement 82
subject 82

S
save

data manually 34
ROI 104
kinetic data 44, 43

scientific image data 211
segment 29
smoothing 67, 208
source spectrum 160
spectral imaging

See planar spectral imaging.
spectral unmixing 127–130

options 134–135
parameters 132–133
PCA biplot 136
PCA explained variance 137
results 131–132

starting the software 9
starting the system

See system initialization.
steradian 214
subject ROI 82, 90
surface topography 139–140
syringe injection system 257–259
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system
FOV 194
initialization 11
optics autofluorescence 235
temperature 11

T
tag an image 58
technical support 3
temperature 11
threshold angle 159
tile images 58
tissue autofluorescence 236–237

eliminate by spectral unmixing 127–130
subtracting with background filters 115–117

tissue properties 160
tool palette 50

3D tools 162–187
correcting/filtering 66–67
image information 67–68
point source fitting 143–146
ROI tools 82

toolbar 261
total source flux 158
transillumination overview 76
troubleshooting guide 189

U
uniform surface sampling 159, 255
units

See display units.
user preferences 195–203

V
voxel 173, 249

size increment 254
size increments 159
size limits 159, 254

vsize
final 159
starting 159

W
well plate autofluorescence 230–231

X
x,y coordinates 174
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